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COMPUTER FUNDAMENTALS:
Computer is an electronic device that is designed to work with Information. The term
computerisderivedfromtheLatinterm‘compute’,thismeanstocalculate.Computercannot
doanythingwithoutaProgram.Itrepresentsthedecimalnumbersthroughastringofbinary digits.
The Word 'Computer' usually refers to the Center Processor Unit plus Internal memory.

CHARLESBABBAGE

Charles Babbage was an English polymath. He was a mathematician, philosopher, inventor
and mechanical engineer, who is best, remembered now for originating the concept of a
programmable computer.

Considereda"fatherofthecomputer",Babbageiscreditedwithinventingthefirstmechanical
computer that eventually led to more complex designs. His varied work in other fields has
led him to be described as "pre-eminent" among the many polymaths of his century.

FUNCTIONALITESOFCOMPUTER:

Any digital computer carries out five functions in gross terms:

• Takes data as input.

• Stores the data /instructions in its memory and can use them when required.

• Processthedataandconvertitintousefulinformation.

• Outputtheinformation.

• Controlalltheabovefoursteps.

Definition

ComputerSystemis anelectronicdataprocessingdevice whichdoes thefollowing:

• Acceptandstoreaninputdata.

• Processthedatainput.

• Andoutputtheprocesseddatainrequiredformat.



ADVANTAGESOFCOMPUTER:

FollowinglistdemonstratestheadvantagesofComputers: High Speed

• Computerisaveryfastdevice.

• Itiscapableofperformingadditionofverybigdata.

• Thecomputerhasunitsofspeedinmicrosecond,nanosecondandeventhepicoseconds.

• It can perform millions of calculations in a few seconds as compared to man who
canspend many months for doing the same task.

Accuracy

• In addition to being very fast, computer is very accurate. • The computer can

perform calculations 100% error free.

• Computersperformalljobswith100%accuracy.

StorageCapability

• Memoryisaveryimportantcharacteristicofacomputer.

• Thecomputerhasmuchmorestoragecapacitythanhumanbeings.

• Itcanstorelargeamountofdata.

• Itcanstoreanytypeofdatasuchasimages,videos,text,audioandanyothertype.

Diligence

• Unlikehumanbeings,acomputerisfreefrommonotony,tirednessandlackof concentration.

• Itcanworkcontinuouslywithoutcreatinganyerrorandboredom.

• Itcandorepeatedworkwithsamespeedandaccuracy.

Versatility

• Acomputerisaveryversatilemachine.

• Acomputerisveryflexibleinperformingthejobstobedone.



• Thismachinecanbeusedtosolvetheproblemsrelatingtovariousdifferentfields.

• Atoneinstant,itmaybesolvingacomplexscientificproblemandtheverynextmoment it may
be playing a card game.

Reliability

• Acomputerisareliablemachine.

• Modernelectroniccomponentshavefailurefreelonglives.

• Computersare designedto makemaintenance easy.

Automation

• Computerisanautomaticmachine.

• Automationmeansabilitytoperformthetaskautomatically.

• Onceaprogram is givento computeri.e. stored incomputermemory, the programand
instruction can controlthe program execution without human interaction.

ReductionInPaperWork

• Theuseof computersfor dataprocessinginanorganization leadsto reduction inpaper work
and speeds up the process.

• Asdatainelectronicfilescanberetrievedasandwhenrequired,theproblemof maintenance of
large number of files gets reduced.

Reduction In Cost

• Thoughtheinitialinvestmentforinstallingacomputerishighbutitsubstantiallyreduces the
cost of each of its transaction.

DISADVANTAGESOFCOMPUTER:

FollowinglistdemonstratesthedisadvantagesofComputersintoday'sarena.

• Acomputerisamachineandhasnointelligenceofitsowntoperformanytask.

• Eachandeveryinstructionhastobegiventothecomputer.

• Acomputercannottakeanydecisiononitsown.Dependency

• Itcanperformfunctionasinstructedbytheuser,soitisfullydependentonhumanbeing.



Environment

• Theoperatingenvironmentofcomputershouldbedustfreeandsuitabletoit.NoFeeling
• Computerhasnofeelingoremotions.

• It cannot make Judgment based on feelings, tastes, experiences and knowledge unlike
a human being.

APPLICATIONSOFCOMPUTER

Banking

TodayBankingisalmosttotallydependentoncomputer. Banks

provide following facilities:

• Banks on-line accounting facility, which include current balances, deposits, overdrafts,
interest charges, shares and trustee records.

• ATMmachinesaremakingiteveneasierforcustomerstodealwithbanks.

Insurance

Insurance companies are keeping all records up to date with the help of computer. The
Insurance Companies, Finance houses and Stock broking firms are widely using computers
for their concerns.

InsuranceCompaniesaremaintainingadatabaseofallclientswithinformationshowing

• howtocontinuewithpolicies

• startingdateofthepolicies

• nextdueinstallmentofapolicy

• maturitydate

• interestsdue

• survivalbenefits

• bonus

Education

ThecomputerhasprovidedalotoffacilitiesintheEducationSystem.

• TheusesofcomputerprovideatoolintheEducationsystemisknownasCBE(Computer Based
Education).



• CBEinvolvesControl,DeliveryandEvaluationoflearning.

• The computer education is very familiar and rapidly increasing the graph of computer
students.

• There are number of methods in which educational institutions can use computer to
educate the students.

• Itisusedforprepareadatabaseaboutstudentperformanceandanalysisarecarriedout.

Marketing

InMarketingusesofcomputerarefollowing:
• Advertising: With computers, advertising professionals create art and graphics, write

and revise copy and print and disseminate ads with the goal of selling more products.
• At Home Shopping: At home shopping has been made possible through use of

computerized catalogues that provide access to product information and permit direct
entry of orders to be filled by the customers.

HealthCare

ComputershavebecomeimportantpartinallMedicalSystems.

The computers are being used in hospitals to keep the record of patients andmedicines. It
is also used in scanning and diagnosing different diseases. ECG, EEG, Ultrasounds and CT
Scans etc. are also done by computerized machines.

Someofmajorfieldsofhealthcareinwhichcomputerareused:
• DiagnosticSystem:Computersareusedtocollectdataandidentifycauseofillness.
• Lab-diagnosticSystem:Alltestscanbedoneandreportsarepreparedbycomputer.
• PatientMonitoringSystem:These are used to check patient's signs for abnormality

such as in Cardiac Arrest, ECG etc.
• PharmaInformationSystem:ComputerchecksDrug-Labels,Expirydates,harmful drug

side effects etc.

• Nowadays,computersarealsousedinperformingsurgery.

Engineering Design

Computersarewidelyusedinengineeringpurposes.

OneofmajorareasisCAD(ComputerAidedDesign).CADprovidescreation,editionand modification of
image. Some fields are:

• StructuralEngineering:Requiresstressandstrainanalysisrequiredfordesignof Ships,
Buildings, Budgets, and Airplanes etc.

• IndustrialEngineering:Computersdealswithdesign,implementationandimprovement of
integrated systems of people, materials and equipments.

• ArchitecturalEngineering:Computershelpinplanningtowns,designingbuildings,
determining a range of buildings on a site using both 2D and 3D drawings.



Military
Computersarelargelyusedindefense.Moderntanks,missiles,weaponsetc.employ computerized
control systems. Some military areas where a computer has been used are:

• MissileControl

• MilitaryCommunication

• Militaryoperationandplanning

• SmartWeapons

Communication

Communication means to convey a message, an idea, a picture or speech that is received
and understood clearly and correctlybythe personfor whom it is meant. Somemain areas in
this category are:

• E-mail

• Chatting

• Usenet

• FTP

• Telnet

• Video-conferencing

Governmentapplications

Computersplayanimportantroleingovernmentapplications.Somemajorfieldsinthiscategory are:

• Budgets

• Salestaxdepartment

• Incometaxdepartment

• Male/Femaleratio

• Computerizationofvoterslists

• ComputerizationofDrivingLicensingsystem



• ComputerizationofPANcard

• WeatherForecasting.

TYPESOFCOMPUTER:

Computercanbebroadlyclassifiedbytheirspeedandcomputingpower.

Sr.
No. Type Specifications

1 PC(PersonalComputer)
Singleusercomputersystem.Moderately
powerful microprocessor.

Singleusercomputersystem.Similarto
2 WorkStation PersonalComputerbuthavemorepowerful

microprocessor.

Multi-usercomputersystem.Capableof
3 MiniComputer supporting hundreds of users

simultaneously.

4 MainFrame

Multi-user computer system. Capable of
supporting hundreds of users
simultaneously. Software technology is
different from minicomputer.

An extremelyfast computer which can
5 Supercomputer performhundredsofmillionsofinstructions

persecond.

INPUTDEVICES

FollowingarefewoftheimportantinputdeviceswhichareusedinComputerSystems

• Keyboard

• Mouse

• JoyStick

• Lightpen



• TrackBall

• Scanner

• GraphicTablet

• Microphone

• MagneticInkCardReader(MICR)

• OpticalCharacterReader(OCR)

• BarCodeReader

• OpticalMarkReader

OUTPUT DEVICES

FollowingarefewoftheimportantoutputdeviceswhichareusedinComputerSystems

• Monitors

• GraphicPlotter

• Printer

CPU(CENTRALPROCESSING UNIT)

• CPUisconsideredasthebrainofthecomputer.

• CPUperformsalltypesofdataprocessingoperations.

• Itstoresdata,intermediateresultsandinstructions(program).

• Itcontrolstheoperationofallpartsofcomputer.

CPU itself hasfollowing threecomponents.

• Memory OrStorageUnit:

• ControlUnit

• ALU(ArithmeticLogicUnit)

Memoryor Storage Unit:



Thisunitcan storeinstruction, dataand intermediate results.Thisunitsuppliesinformation
totheotherunitsofthecomputerwhenneeded.Itisalsoknownasinternalstorageunitor main
memory or primary storage or Random access memory (RAM).

Itssizeaffectsspeed,powerandcapability.Thereareprimarymemoryandsecondarymemory two
types of memories in the computer.

FunctionofMemoryUnitis:

Itstoresallthedatatobeprocessedandtheinstructionsrequiredforprocessing. It stores

intermediate results of processing.

Itstoresfinalresultsofprocessingbeforetheseresultsarereleasedtoanoutputdevice. All inputs

and outputs are transmitted through main memory.

Control Unit:
This unit controls the operations of all partsof computer. It doesnot carryout anyactualdata
processing operations.

Functionsofthisunitare

Itisresponsibleforcontrollingthetransferofdataandinstructionsamongotherunitsofa computer.

Itmanagesandcoordinatesalltheunitsofthecomputer.

It obtains the instructions from the memory, interprets them and directs the operation of the
computer.

ItcommunicateswithInput/outputdevicesfortransferofdataorresultsfromstorage. It

does not process or store data.

ALU(ArithmeticLogicUnit):

Thisunitconsistsoftwosub-sectionsnamely

• Arithmeticsection

• LogicSection

ARITHMETICSECTION



Function of Arithmeticsection is to perform arithmeticoperations like addition, subtraction,
multiplication and division. All complex operations are done by making repetitive use of
above operations.

LOGIC SECTION
Function of logic section is to perform logic operations such as comparing, selecting, matching
and merging of data.

Unitsof Computer MemoryMeasurements

1Bit=BinaryDigit(BitsofComputerare0and1) 8 Bits
= 1 Byte
1024Bytes=1KB(KiloByte)
1024 KB = 1 MB (Mega Byte)
1024 MB = 1 GB(Giga Byte)

Computer Memory
Incomputing,memory referstothephysicaldevicesusedtostoreprograms(sequencesof
instructions)ordata(e.g.programstateinformation)onatemporaryorpermanentbasisfor
useinacomputerorotherdigitalelectronicdevice.Thetermprimarymemoryisusedforthe
informationinphysicalsystemswhichfunctionathigh-speed(i.e.RAM),asadistinctionfrom
secondarymemory,whicharephysicaldevicesforprogramanddatastoragewhichareslow to
access but offer higher memorycapacity. Primarymemorystored on secondarymemory is
called "virtual memory". An archaic synonym for memory is store.
The term "memory", meaning primary memory is often (but not always) associated with
addressable semiconductor memory, i.e. integrated circuits consisting of silicon-based
transistors,usedforexampleasprimarymemorybutalsootherpurposesin computersand
otherdigitalelectronicdevices.Therearetwomaintypesofsemiconductormemory:volatile and
non-volatile. Examples of non-volatile memory are flash memory (sometimes used as
secondary, sometimes primary computer memory) and ROM/PROM/EPROM/EEPROM
memory (used for firmware such as boot programs). Examples of volatile memory are
primary memory (typically dynamic RAM, DRAM), and fast CPU cache memory (typically
staticRAM,SRAM,whichisfastbutenergy-consumingandofferlowermemorycapacityper area
unit than DRAM) .

Volatile memory

Volatilememoryiscomputermemorythatrequirespowertomaintainthestoredinformation. Most
modern semiconductor volatile memory is either Static RAM or dynamic RAM. SRAM retains
its contents as long as the power is connected and is easy to interface to but uses six
transistors per bit. Dynamic RAM is more complicated to interface to and control and needs
regular refresh cycles to prevent its contents being lost. However, DRAM uses only one
transistor and a capacitor per bit, allowing it to reach much higher densities and, with more
bits on a memory chip, be much cheaper per bit. SRAM is not worthwhile for desktop
system memory, where DRAM dominates, but is used for their cache memories. SRAM is
commonplace in smallembedded systems, which might onlyneed tens of kilobytes or less.



Forthcoming volatile memorytechnologies that hopeto replaceor compete with SRAM and
DRAMincludeZ-RAM,TTRAM,A-RAMandETARAM.

Non-volatilememory

Non-volatilememoryiscomputermemorythatcanretainthestoredinformationevenwhen not
powered. Examples of non-volatile memory include read-only memory(ROM), flash
memory,mosttypesofmagneticcomputerstoragedevices(e.g.harddisks,floppydiscsand
magnetic tape), optical discs, and early computer storage methodssuch as paper tape and
punched cards.

OperatingSystem

Anoperatingsystemisaprogramthatactsasaninterfacebetweenthesoftwareandthe computer
hardware.

• Itisanintegrationsetofspecializedprogramsthatareusedtomanageoverallresources and
operations of the computer.

• It is specialized software that controlsand monitors the execution of all otherprograms
that reside in the computer, including application programs and other system software.

ObjectivesofOperating System

• Makingacomputersystemconvenienttouseinanefficientmanner

• Tohidethedetailsofthehardwareresourcesfromtheusers

• Toprovideusersaconvenientinterfacetousethecomputersystem.

• To act as an intermediary between the hardware and its users and making it easier for
the users to access and use other resources.

• Managetheresourcesof acomputersystem.

• Keep track of who is using which resource, granting resource requests, according for
resource using and mediating conflicting requests from different programs and users.

• Theefficientandfairsharingofresourcesamongusersandprograms

CharacteristicsofOperatingSystem
• MemoryManagement--Itkeepstracksofprimarymemoryi.e.whatpartofitareinuse by

whom, what part are not in use etc. Allocates the memory when the process or
program request it.

• Processor Management -- Allocate theprocessor (CPU)to aprocess.
De-allocate processor when processor is no longer required.



• Device Management -- Keep tracks of all devices. This is also called I/O controller.
Decides which process gets the device when and for how much time.

• File Management -- Allocates the resources. De-allocates the resources. Decides who
gets the resources.

• Security --Bymeansofpasswords&similarothertechniques,preventingunauthorized
access to programs & data.

• Jobaccounting--Keepingtrackoftime&resourcesusedbyvariousjobsand/orusers.

• Control over system performance -- Recording delays between request for a service
& from the system.

• Interaction with the operators --Theinteractionmaytakeplaceviatheconsoleofthe
computer in theform of instructions. OperatingSystem acknowledges the same, dothe
corresponding action and inform the operation by a display screen.

• Error-detecting aids -- Production of dumps, traces, error messages and other
debugging and error-detecting methods.

• Coordination between other software and users -- Coordination and assignment of
compilers, interpreters, assemblers and other software to the various users of the
computer systems.

WINDOWS7

Windows 7 is an operating system produced by Microsoft for use on personal computers,
including home and business desktops, laptops, net books, tablet PCs, and media centerPCs.
It was released to manufacturing on July 22, 2009, and became generally availableretail
worldwide on October 22, 2009, less than three years after the release of its
predecessor,Windows Vista. Windows 7's server counterpart, Windows Server 2008 R2, was
released at the same time. Windows 7 is succeeded by Windows 8.

Unlike Windows Vista's many new features, Windows 7 was an incremental upgradedesigned
to work with Vista-compatible applications and hardware. Presentations given by Microsoft in
2008 focused on multi-touch support, an updated Windows shell with a new taskbar,
referred to internally as the Superbar, a home networking system called Home Group,and
performance improvements. Some standardapplications thathave beenincluded with prior
releases of Microsoft Windows, including Windows Calendar, Windows Mail, Windows
MovieMaker, and Windows Photo Gallery,are not includedin Windows 7;mostare instead
offered separately at no charge as part of the Windows Essentials suite.

InstallWindows7

ManypeoplehavecomputersthatcomewithWindows7sotheymayneverhavetoinstallit. However,
you may need to install Windows 7 if:



• Youreplacedyourharddiskdrivewithanewharddiskdrivethatdoesnothave Windows 7
installed.

• YouarereinstallingWindows7onacomputerbecauseyouwanttocleanoffyourhard drive and
remove any unwanted programs, such as spyware.

• Youpurchasedacomputerwithoutanoperatingsystem.

Pre-installation checklist

Beforeyoubegintheinstallationprocess,usethischecklisttomakesurethatyouareprepared:

• YouhavetheWindows7CD.
• You have theproductkeyavailable. The product keyislocatedonyourWindows7 CD case

and is required to install and activate Windows 7.
• Your computer hardware is set up. At a minimum, you should connect your keyboard,

mouse,monitor,andCDdrive.Ifavailable,youshouldconnectyourcomputertoawired network.
• You have Windows 7 drivers available. Drivers are software that Windows 7 uses to

communicate with your computer’s hardware. If you do not have drivers available,
Windows7mayalreadyincludedriversforyourhardware.Ifnot,youshouldbeableto
download themfrom your hardware manufacturer’s website afteryou set upWindows 7.

• If you are reinstalling Windows 7 on an existing computer, you need a backup copyof
your files and settings. The installation process will delete all of your files. You
can use the File and Settings Transfer Wizard to store your files and settings on
removable media and then restore them after installation is complete.

Installation process

InstallingWindows7cantakeuptotwohours.Tomaketheprocessmoremanageable,ithas been broken
up into several sections.

ToBeginInstallation:

1. InserttheWindows7CDintoyourcomputerandrestartyourcomputer.
2. IfpromptedtostartfromtheCD,pressSpacebar.Ifyoumisstheprompt(itonlyappears for a

few seconds), restart your computer to try again.
3. Windows7Setupbegins.Duringthisportionof setup,yourmousewillnotwork,soyou must use

the keyboard. On the Welcome to Setup page, press Enter.
4. On the Windows 7 Licensing Agreement page, read the licensing agreement. Press the

Page Down key to scroll to the bottom of the agreement. Then press F8.
5. ThispageenablesyoutoselecttheharddiskdriveonwhichWindows7willbeinstalled.

Onceyoucompletethisstep,alldataonyourharddiskdrivewillberemovedandcannot
berecovered.Itisextremelyimportantthatyouhavearecentbackupcopyofyourfiles before
continuing. When you have a backup copy, press D, and then press L when prompted.
This deletes your existing data.

6. PressEntertoselectunpartitionedspace, which appearsbydefault.



7. PressEnteragaintoselectFormatthepartitionusingtheNTFSfilesystem,which appears by
default.

8. Windows7erasesyourharddiskdriveusingaprocesscalledformattingandthencopies the
setup files. You can leave your computer and return in 20 to 30 minutes.

ToContinuetheInstallation

1. Windows7restartsandthencontinueswiththeinstallationprocess.Fromthispoint
forward, you can use your mouse. Eventually, the Regional and Language Options
page appears. Click Next to accept the default settings. If you are multilingual or
preferalanguageotherthanEnglish,youcanchangelanguagesettingsaftersetup is
complete.

2. On the Personalize Your Software page, type your name and your organization
name.Someprogramsusethisinformationtoautomaticallyfillinyournamewhen
required. Then, click next.

3. OntheYourProductKeypage,typeyourproductkeyasitappearsonyourWindows 7 CD
case. The product key is unique for every Windows 7 installation. Then, click Next.

4. On the Computer Name and Administrator Password page, in the Computer name
box, type a name that uniquely identifies your computer in your house, such as
FAMILYROOM or TOMS. You cannot use spaces or punctuation. If you connect your
computertoa network, you will use this computer name tofind sharedfilesand printers.
Type a strong password that you can remember in the Administrator password box,
and then retype it in the Confirm password box.Write the password down and store
it in a secure place. Click Next.

5. OntheDateandTimeSettingspage,setyourcomputer’sclock.Then,clicktheTime Zone
down arrow, and select your time zone. Click Next.

6. Windows7willspendaboutaminuteconfiguringyourcomputer.OntheNetworking
Settings page, click next.

7. OntheWorkgrouporComputerDomainpage,clickNext.

To complete the installation

1. Windows 7 will spend 20 or 30 minutes configuring your computer and will
automatically restart when finished. When the Display Settings dialog appears, click
OK.

2. WhentheMonitorSettingsdialogboxappears,click OK.
3. The final stage of setup begins. On the Welcome to Microsoft Windows page,

clickNext.
4. On the Help protect your PC page, click Help protect my PC by turning on Automatic

Updates now. Then, click Next.
5. Windows7willthencheckifyouareconnectedtotheInternet:

o If you are connected to the Internet, select the choice thatdescribes your
networkconnectionontheWillthiscomputerconnecttotheInternetdirectly,or
throughanetworkpage.Ifyou’renotsure,acceptthedefaultselection,andclick Next.o
If you usedial-up Internet access, orifWindows 7 cannot connect to



theInternet,youcanconnecttotheInternetaftersetupiscomplete.OntheHow will this
computer connect to the Internet? Page, click Skip.

6. Windows7SetupdisplaystheReadytoactivateWindowspage.Ifyouareconnected to the
Internet, click Yes, and then click Next. If you are not yet connected to the Internet,
click No, click Next, and then skip to step 24. After setup is complete,
Windows7willautomaticallyremindyoutoactivateandregisteryourcopyofWindows 7.

7. OntheReadytoregisterwithMicrosoftpage,clickYes,andthenclickNext.
8. OntheCollectingRegistrationInformationpage,completetheform.Then,clickNext.
9. On theWho will use this computer page, type the name of each person who will use

the computer? You can use first names only, nicknames, or full names. Then click
Next.

10.OntheThankyou!Page,clickFinish.

Windows 7 setup is complete. You can log on by clicking your name on the logon
screen. If you’ve installedWindows 7 on a new computer or new hard disk drive,
youcannowusetheFileandSettingsTransferWizardtocopyyourimportantdata to your
computer or hard disk drive.

MS-DOS

Short for Microsoft Disk operating system, MS-DOS is a non-graphical command line
operatingsystemderivedfrom86-DOSthatwascreatedforIBMcompatiblecomputers.MS-
DOSoriginallywrittenbyTimPetersonandintroducedbyMicrosoftinAugust1981andwas last
updated in 1994 when MS-DOS 6.22 was released. Today, MS-DOS is no longer used;
however,thecommandshell,morecommonlyknownastheWindowscommandlineisstill used
by many users.

Today,mostcomputerusersareonlyfamiliarwithhowtonavigateMicrosoftWindowsusing the
mouse UnlikeWindows, MS-DOS is a command-line and is navigated by using MS-DOS
commands.Forexample,ifyouwantedtoseeallthefilesinafolderinWindowsyouwould double-
clickthefoldertoopenthefolderinWindowsExplorer.InMS-DOS,toviewthatsame
folderyouwouldnavigatetothefolderusingtheCDcommandandthenlistthefilesinthat folder
using the dir command.

DOS Commands

MS-DOS has a relatively small number of commands, and an even smaller number of
commonly used ones. Moreover, these commands are generally inflexible because, in contrast
to Linux andother Unix-like operating systems, they are designed to

accommodatefewoptionsorarguments (i.e.,valuesthatcanbepassedtothecommands).



Some of the most common commands are as follows (corresponding commands on Unixlike
operating systems are shown in parenthesis):

CD-changesthecurrentdirectory(cd)
COPY - copies a file (cp)
DEL-deletesa file(rm)
DIR-listsdirectorycontents(ls)
EDIT-startsaneditortocreateoreditplaintextfiles(vi,vim,ed,Joe) FORMAT
- formats a disk to accept DOS files (mformat)
HELP-displaysinformationaboutacommand(man,info)
MKDIR - creates a new directory (mkdir)
RD-removesadirectory(rmdir)
REN - renames a file (mv)
TYPE-displayscontentsofafileonthescreen(more,cat)

OtherDOSCommand commonlyused are:

Append
Theappend commandcanbeusedbyprogramstoopenfilesinanotherdirectoryasifthey were
located in the current directory.
Attrib
Theattribcommandisusedtochangetheattributesofasinglefileoradirectory.
Break
ThebreakcommandsetsorclearsextendedCTRL+Cchecking.

Call
Thecallcommandisusedtorunascriptorbatchprogramfromwithinanotherscriptorbatch program.
Thecallcommandhasnoeffectoutsideofascriptorbatchfile.Inotherwords,runningthe call
command at the DOS prompt will do nothing.
Chcp
The chcp command displaysor configures the active codepage number.
Chdir
Thechdircommandisusedtodisplaythedriveletterandfolderthatyouarecurrentlyin.Chdir can also
beused to change the drive and/ordirectorythat you wantto workin.
Chkdsk
Thechkdskcommand,oftenreferredtoascheck disk,isusedtoidentifyandcorrectcertain hard drive
errors.
Choice
Thechoicecommandisusedwithinascriptorbatchprogramtoprovidealistofchoicesand return the
value of that choice to the program.
Cls
Theclscommandclearsthescreenofallpreviouslyenteredcommandsandothertext.Dir



Thedircommandisusedtodisplayalistoffilesandfolderscontainedinsidethefolderthat you are
currently working in.
Thedircommandalsodisplaysotherimportantinformationliketheharddrive'sserialnumber,
thetotalnumberoffileslisted,theircombinedsize,thetotalamountoffreespaceleftonthe drive, and
more.
DIR[drive:][path][filename][/P][/W][/A[[:]attributes]][/O[[:]sortorder]][/S][/B][/L][/V]

[drive:][path][filename]
Specifiesdrive,directory,orfilestolist.(Couldbeenhancedfile

specificationormultiplefilespecs)

/P Pauses aftereachscreenful ofinformation.

/W Useswidelistformat.

attributes: D
Directories
RRead-onlyfiles

/A HHiddenfiles
AFilesreadyforarchiving S
System files
-Prefixmeaningnot

Listbyfilesinsortedorder,sortorder: N
By name (alphabetic)
SBysize(smallestfirst)
EByextension(alphabetic)

/O
DBydateandtime(earliestfirst) G
Group directories first
-Prefixtoreverseorder
AByLastAccessDate(earliestfirst)

/S Displaysfilesinspecifieddirectoryandallsubdirectories.

/B Usesbareformat(noheadinginformationorsummary).
/LUseslowercase.

/V Verbosemode.

MS-PAINT
Paint is adrawing tool you can useto createsimple orelaborate drawings. These drawings
canbeeitherblack-and-whiteorcolor,andcanbesavedasbitmapfiles.Youcanprintyour
drawing,useitforyourdesktopbackground,orpasteitintoanotherdocument.Youcaneven use
Paint to view and edit scanned photos.

YoucanalsousePainttoworkwithpictures,suchas.jpg,.gif,or.bmpfiles.Youcanpaste
aPaintpictureintoanotherdocumentyou'vecreated,oruseitasyourdesktopbackground.



Todrawastraightline
1. Inthetoolbox,clickLine .
2. Belowthetoolbox,clickalinewidth.
3. Dragthepointertodrawtheline.

Todraw a freeformline
1. Inthetoolbox,clickLine .
2. Dragthepointertodrawtheline.

Todraw acurvedline
1. Inthetoolbox,clickCurve .
2. Belowthetoolbox,clickalinewidth.
3. Drawastraightlinebydraggingthepointer.
4. Click where you want one arc of the curve to be, and then drag the pointer to adjust the

curve. Repeat this step for a second arc. You can only create two curves for each line.

Tosend animageusing e-mail
Afteryouaredoneworkingonanimage,youcansendittoanyonewhohasane-mailaccount (as long as
you also have access to an e-mail account).
1. OntheFilemenu,clickSend.
2. Youre-mailprogramwilldisplay,withyourimageincludedeitherasanattachmentoraspart of the

message section of your e-mail.
3. Specify your recipient's e-mail address, a subject, and a message; then send the email as

you normally would.

Todraw arectangleorsquare
1. In the toolbox, click Rectangle to create a square-cornered shape, or click

RoundedRectangle to create a round-cornered shape.
2. Belowthetoolbox,clickafillstyle.
3. Todrawarectangle,dragthepointerdiagonallyinthedirectionyouwant.
4. Todrawasquare,holddownSHIFTwhiledraggingthepointer.

Toacquireanimagefromascanneroradigitalcamera 1. On
the File menu, click From Scanner or Camera.
2. IntheGetPicturesdialogbox,clicktheimageyouwant,andthenclickGetPicture.

NOTEPAD

Notepadoverview
NotepadisabasictexteditoryoucanuseforsimpledocumentsorforcreatingWebpages. The most
common use for Notepad is to view or edit text (.txt) files, but many users find Notepad a
simple tool for creating Web pages.
Because Notepad supports only very basic formatting, you cannot accidentally save special
formattingindocumentsthatneedtoremainpuretext.Thisisespeciallyusefulwhencreating HTML
documents for a Web page because special characters or other formatting may not appear
in your published Web page or may even cause errors.



You can save your Notepad files as Unicode, ANSI, UTF-8, or big-endian Unicode. These
formats provide you greater flexibility when working with documents that use different
character sets.
WORDPAD
WordPad is a basic word processor that is included with almost all versions of Microsoft
Windows from Windows 95 onwards. It is more advanced than Notepad but simpler than
Microsoft Works Word Processor and Microsoft Word. It replaced Microsoft Write.
UsingWordPad

WordPad is a basic word processor that is included in Windows. A word processor is a
computer program that you can use to create, edit, view, and print text documents. With
WordPad, you can type letters, book reports, and other simple documents. You can also
change how the text looks, quickly move sentences and paragraphs around, and copy and
paste text within and between documents.

TheWordPadwindow
To open WordPad, click the Start button , click All Programs, click Accessories, and then
click WordPad.
TherearefourmainpartsoftheWordPadwindow:

The toolbar: The toolbar contains buttons for basic commands, including saving and
printing.Tofindoutwhatabuttondoes,restyourmousepointeronit.Aboxpopsupshowing the
function of the button.

The format bar: The format bar contains buttons that you can use to format the text in your
document. For example, you can choose thefont, color, and alignment of your text.

Theruler:Usetherulertocheckthelayoutandplacementoftextinyourdocument.

The document area:This is where you type your document, make changes to the text, and
apply your formatting.

Typing text: When you're ready to get started, type in the document area of WordPad. A
flashingverticallinecalledthecursorindicateswherethenexttextthatyoutypewillappear. Tomove
the cursor within text, click where you want the cursor to appear.

Unlike usinga typewriter, when you type inWordPad you don'thavetopress ENTERto start a
newline.WordPad will take care of thatfor you byautomaticallystarting a newline when you
reach the end of the one you're working on. When you want to start a new paragraph, press
ENTER.

Selectingtext

Wheneveryou wanttodosomethingtotext in yourdocument,such ascopyit orformatit,
youneedtoselectitfirst.Toselecttext,positionthemousepointertotheleftofwhereyou
wanttobeginyourselection.Withthepointerpositioned,clickandholdtheleftmousebutton while
you drag the pointer over the text that you want to select. The selected text will be
highlighted. Once you've completed your selection, release the mouse button.

Copyingandmovingtext



Ifyouhavetextinonepartofyourdocumentthatyouwanttoappearinanotherpart,there
aretwowaystomovethetextaroundwithouthavingtoretypeit:Youcancopyandpasteit to another
location, or you can move it to another location.

When you copy text, it is placed in the Clipboard. You can then paste it in a different location.
The original text is preserved.

When you move text to another location, the original text is not preserved. You might find
this method useful when you want to rearrange the sentences and paragraphs in your
document.

To copytext and paste it in another location

1. Selectthetextthatyouwanttocopy.

2. OntheEditmenu,clickCopy.

3. Movethecursortothelocationwhereyouwanttoinsertthecopiedtext.

4. OntheEditmenu,clickPaste.

Tip

• Toquicklycopytextthatyou'veselected,pressCTRL+C.Topasteit,press CTRL+V.

Insertinganddeletingtext

WordPad makes it easy to insert and delete text wherever you want. To insert text, click
whereyouwanttoinsertthetextandthenjuststarttyping.Todeletetext,selectthetextthat you want
to delete, and then press DELETE.

Formattingyour document

Formattingrefersto the howthe text in yourdocument looksas wellas howit is arranged.
WordPad lets you easily change the formatting in your document. For example, you can
choose from many different fonts and font sizes, and you can make your text almost any
color you want. You can also easily change how your document is aligned.

Tochangethefont,fontstyle,orfontsize:

1. Selectthetextwhoseformattingyouwanttochange.
2. OntheFormat menu,clickFont.

3. IntheFontbox,typeorselectthefontyouwanttouse.

4. IntheFontStylebox,typeorselectthefontstyleyouwant.

5. IntheSizebox,typeorselectthesizeyouwanttouse.

Tochange the color

1. Selectthetextwhosecoloryouwanttochange.



2. OntheFormat menu,clickFont.

3. UnderColor,clickthecolorthatyouwant.

Tochange the alignment

Youcanalignthetextinyourdocumenttoeithertheleftmargin,thecenter,ortherightmargin.

1. Selecttheparagraphwhosealignmentyouwanttochange.

2. OntheFormat menu,clickParagraph.

3. IntheAlignmentbox,clickthealignmentyouwant.

Savingyourdocument

It'sagoodideatosaveyourdocumentperiodicallywhileyouareworkingonitsothatincase
yourcomputerstopsworkingforsomereason,youwon'tloseanyof yourwork.Savingthe
documentwillalsoallowyoutocomebacktoitlaterif youwanttoworkonitagain.

Tosavethedocument

• OntheFilemenu,clickSave.

Ifyouhaven'tsavedthedocumentyet,you'llbeaskedtoprovideanameforthedocument and
location on your computer to save it to:

1. IntheSaveinbox,clickthelocationwhereyouwanttosavethedocument.

2. IntheFilenamebox,typeanameforyourdocument.

3. Click Save.

Printingyourdocument

OntheFilemenu,clickPrint.InthePrintdialogbox,usethePageRangeboxandthe
Numberofcopiesboxtospecifywhichpagesyouwanttoprintaswellashowmanycopies. When
you're done, click Print.

Microsoft Office is an office suite of desktop applications, servers and services for the
MicrosoftWindowsandOSXoperatingsystems,introducedbyMicrosoftonAugust1,1989.
Initiallyamarketingtermforabundledsetofapplications,thefirstversionofOfficecontained
Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. Over the years, Office
applications have grown substantially closer with shared features such as a common spell
checker,OLEdataintegrationandMicrosoftVisualBasicforApplicationsscriptinglanguage.



MicrosoftalsopositionsOfficeasadevelopmentplatformforline-of-businesssoftwareunder the
Office Business Applications brand. Office is reported to now be used by over a billion
people worldwide.

ThecurrentversionsareOffice2013forWindows,releasedonOctober11,2012andOffice
2011forOSX,releasedOctober26,2010.On24October2012,theRTMfinalcodeofOffice 2013
Professional Plus has been released to TechNet and MSDN subscribers for download. On
15 November 2012, the 60-day trial version of Office 2013 Professional Plus was
released for download.

MS-WORD
Microsoft Word is an example of a program called a “word processor.” The key benefit to
using a word processor is that you can make changes easily, including correcting spelling;
adding, deleting, formatting, and relocating text; and inserting images. Once you create a
document, you can effortlessly print it (as many copies as you want!), save it for later
modifications, or send it to a friend via e-mail. Microsoft Word is a very powerful word
processor—this handout was created using just a small number of its features!

MicrosoftWord is available on both PCs and Macs, so what you learn in class today should
be applicable to any computer you use. The program may look slightly different depending
ontheversionandcomputerthatyou’reusing,butMicrosoftWordwillfunctioninthesame basic
ways. There are other word processors out there, including OpenOffice.org Writer,
WordPerfect, Apple Pages, and WordPad. They have many features in common with
Microsoft Word, and you should feel free to choose any program you prefer.

OpeningMicrosoft Word
To get started with Microsoft Word (sometimes called “MS Word”), you will need to locate
andopentheprogramonyourcomputer.Toopentheprogram,pointtoWord’sicononthe
desktopwithyourmouseanddouble-clickonitwiththeleftmousebutton.If youdon’tsee the
MSWordicon on yourdesktop,you’ll have to accessthe program from the Start Menu. Click
on the button in the bottom left corner to pull up the Start Menu. You should see the
MSWord icon here,so click on itonce withyourleft button.If youstilldon’tseeit,click on “All
Programs” and scroll through the list of programs until you find it. Click once with your left
button to open the program. Occasionally, Microsoft Word will be in a folder called
“MicrosoftOffice”orsomethingsimilar—thiswillmakeonemorestepbetween“AllPrograms” and
“Microsoft Word.”

MSWordwillthenopenablankpagecalled“Document1.”
Thisisanimageoftheupper-leftcornerofMSWord.Thisboxfeaturestwoimportantpieces
ofinformation:thenameofthefilethatyouarecurrentlyworkingon(inthiscase,“Document 1” since
we have not yet renamed it) and which program you are using (“Microsoft
Word”).Thereshouldnowbeablinkinglineinthetopleftcornerofthepartofthescreenthat looks
like a sheet of paper. This means you will be able to type in this space!



MicrosoftWordFeatures

TheTitleBar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Itshowsthename
ofthefile(here,“MicrosoftWord”)andthenameoftheprogram(“MicrosoftWord”).Notice
thethreebuttonsontherightside,controllingthesizeandclosingoftheprogram.Minimize:
Leftclickthisbuttontoshrinkthewindowdowntoasmallbuttonthatwillappearinthetask bar
Maximize: Left click this button to make the window as large as it can be—it should take up
your entire screen.
Close:Left-clickthisbuttontoclosethewindow.Theprogramwillcloseandstoprunning.Make sure
you save your work first!
RestoreDown:
Left-click this button to make the windowsmaller without minimizing it. The tabbed Ribbon
menusystemishowyounavigatethroughWordandaccessvariousWordcommands.Ifyou have
used previous versions of Word, the Ribbon system replaces the traditional menus.

The File Menu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the top
left-hand corner. In Microsoft Office 2010, this hasbeen replacedwith a tab in the
Ribboncalled“File.”
Whenyouleft-clickonthistab,adrop-downmenuappears.Fromthismenu,youcanperform the
same functionsaswere found underthe MicrosoftOffice Button menu, such as: Create a new
document, open files, save files in a variety of ways, and print.
QuickAccessToolbar



Onthetopleft-handsideoftheTitleBar,youwillseeseverallittleiconsabovetheFilemenu. These let
you perform common tasks, such as saving and undoing, without having to find them in a
menu.We’llgo over the meanings of the icons a little later.

TheHomeTab

The most commonly used commands in MS Word are also the most accessible. Some of
these commandsavailable in the HomeTab are: The HomeTabToolbaroffersoptionsthat
canchangethefont,size,color,alignment,organizationandstyleofthetextinthedocument. For
example, the “Times New Roman” Indicates the FONT of your text, the “12” indicates
theSIZEofyourtext;etc.Wewillgooverhowtousealloftheseoptionstoformatyourtext
inalittlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-clickonthetinydown-
arrowinthebottomrightcornerofthewindow.TherulerisfoundbelowtheRibbon.Theruler
tellsyouwhereyouareonthepage,alongwiththedimensionsoftheoveralldocument.Just like a
realpieceof paper,thedefaultsettingis 8.5 x11 inches, andthemargins have been
incorporated for you. Similar to most options in MS Word, this is entirely customizable and
the user can create a document of any dimensions.

Keyboard Review

In order to use MS Word effectively, you must input commands using both the mouse and
thekeyboard.Theaboveimageofakeyboardshouldlooksimilartothekeyboardinfrontof
you;learningjustafewcertainkeyswillhelptoimproveyourefficiencyintyping,aswellas
presentyouwithmoreoptionswithintheprogram.Thefollowingisalistofcommonlyused
keysthathavespecialfunctionsinMSWord(keyfunctionscanchangedependingonwhich program
you are using):

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondary

Function.

4. Spacebar:This keyentersa spacebetween wordsorletters.

5. Tab:Thiskeywillindentwhatyoutype,ormovethetexttotheright.Thedefault Indent
distance is usually ½ inch.

6. CapsLock:Pressingthiskeywillmakeeveryletteryoutype capitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter:This keyeithergives you anewline,or executesa command(pressedinMSWord, it

begins a new line).



9. NumberKeypad:Theseareexactlythesameasthenumbersatthetopofthe

Keyboard; some people just find them easier to use in this position.

10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocument.

MICROSOFT WORDBASICS

TypingText

Toentertext,typejustasyouwouldifyouwereusingatypewriter.Tocapitalizealetter,hold down the
SHIFT key while typing the letter. Or, press the CAPS LOCK key on the lefthand side of
your keyboard. You will have to press the CAPS LOCK key again—once you
aredonecapitalizing—toremovethelock.YoudonotneedtopressENTERtostartanewline—
Microsoft Word will automatically wrap your sentence at the end of the line. To move the
cursor from its position at the end of your sentence to anywhere else on the page, use the
mouseorthearrowkeystomovethecursorwhereyouwantthelettersorspacestobe(left- click the
mouse to place the cursor) and then type what you want to add—the text will
automaticallyadjust to include it. Press ENTER to starta newparagraph (this is sometimes
called a “carriage return”).

Deleting Text

Whiletypingadocument,sometimesyouwillmakeamistake.Unlikeatypewriter,MSWord can
delete text on thescreen and leave no trace—it is as if you never typed on the page in
thefirst place.There are two different buttons on the keyboard that will allowyou to erase
text. Theyare the “Delete” keyand the “Backspace” key(#s 1 and2 on the keyboardmap
onpage.The“Backspace”keydeleteswordstotheLEFTofthecursor,andthe“Delete”key deletes
words to the RIGHT of the cursor.

BACKSPACE↔ DELETE

Let’sassumethattheverticallinedissectingtheword“creative”intheexampleaboveisour cursor.
Pressing the “Backspace” key will erase “a,” “e,” “r,” “c,” and so on, moving LEFT.
The“Delete”keywillerase“t,”“i,”“v,”“e,”andsoon,movingRIGHT.

Todeleteawholechunkoftextatonce,left-clickwithyourmouseanddragtohighlightasection of text.
Then simply press “Backspace” or “Delete” and all of the highlighted
Textwilldisappear.

Undoingand Redoing

The UNDO and REDOfeatures of MicrosoftWindows applicationsare great tools to relyon.
Theprogramwillkeepalistofthelast25commandsthatyouhaveperformed,anditallows for taking
“one step” backwards in order to erase what you have just done. Click on the UNDO button
in the Quick Access Toolbar to go back one step. Click on the REDO buttonin the Quick
Access Toolbar to go forward one step.



FormattingText

Changingthelookofwhatyou’vewritteniscalled“formatting.”Thiscanincludechangingthe
textstyle,size,color,andmore.Thisisasentencethatfeaturesmanydifferentfonts.Thisis a
sentence that features many different sizes. From the Home Tab, the “B” will make your
text BOLD, the “I”will put it in italics, and the“U” willadd an underline to yourtext. These
featuresdonothavetobeusedindependentlyofeachother—inotherwords,youcanbold,
underline,anditalicizeasinglepieceof text.Thealignmentofthetextcanbealteredusing the
buttons with the horizontal lines on them. You can align text To the LEFT, To the CENTER
and to the RIGHT.

In order to apply certain stylistic or formatting changes to text, you must first
HIGHLIGHT the text. This is a common procedure in Microsoft Windows applications, and
because it is so useful, it is a skill worth practicing. You can also change the font color by
clicking on the appropriate buttons in the

Formatting Toolbar. Experiment and remember—you can always start over with a fresh,
newdocument, sodon’t worryaboutmakingmistakes! If you do,however, there is always the
incredible “UNDO” tool. Cutting, Copying, and PastingText in MSWord, you can CUTor COPY
text from one area of the document and save that text to be PASTED elsewhere (these
commands are found on the Home Tab). When you CUT text, you actually delete it from
where you took it, as opposed to COPYING it, which makes a copy of your selection.

When you CUT or COPY text, it is stored on the CLIPBOARD. The Clipboard is a tool in MS
Wordthatstorescutsandcopiesofyourwork,tobepastedinotherplacesinthedocument. Once
your selection is on the CLIPBOARD, you can PASTE it as many times as you want!
CUTTING a selection will place it on the clipboard, just in case you want to PASTE it
elsewhere.ToCUTaselection,firsthighlight it.Then,click ontheCUT iconfromtheHome
Tab.Thehighlightedtextwilldisappear,asyouhavejustcutitout,butacopyisnowonyour clipboard,
and MS Word is waiting for you to paste it somewhere else.

To PASTE this cut selection,place your cursor where you want the selection to go. Click on
the PASTE icon from the Home Tab toolbar, and it will pop the text into place, right where
you have your cursor. To COPY, simply follow those same steps, replacing the CUT
command with COPY. The COPY command will not alter your original selection at all, as it
simplymakes a copy of the selection without changing or deleting it in any way.

DOINGMORE WITHMICROSOFT WORD

InsertingImagesandClipArt

WithMicrosoftWord,youcaninsertpicturesinyourdocumentusingtheInsertTabtoolbar. You can
insert pictures from the “Clip Art” album that comes with the program, or you can insert
pictures from a file that you have previously saved on a disk or elsewhere on the
computer(e.g.,theMyPicturesfolder).ClipArtisacollectionofcartoonandcomputer-



generated images that cover a broad array of commonly needed icons and pictures. These
include business, holiday, nature, entertainment, academic and other themes, along with
standard bullets and symbols.

ToinsertaclipartpictureintoaMicrosoftWorddocument,youwillfirstneedtoplaceyour cursor(left-
click)whereyouwishtoinsertyoupictureinyourdocument.Then,fromtheInsert
tabontheRibbon,clickon “Clip Art.” AClipArtsearchboxwillappearontherightsideof
yourscreen. Fromhere, you canentera search wordforthepicture you would liketofind. Then
click “Go.” This will show all the options of pictures you can insert. When you see a
pieceofclipartthatyoulike,clickonit,anditwillautomaticallyinsertintoyourdocument,in the exact
place where you left the cursor.To resize your image, grab one of the cornersof the image
by left-clicking and holding—drag it to your desired size and fine-tune the
placement.Thecursorwillchangefromatypingicontoadoublearrowwhenitcanbeused to resize
an image.

Drag the corner toward the upper-left corner of the screen, and the image will grow. Drag
towardthebottom-right,anditwillshrink.Youcanmovetheimagetoanotherplaceinthe
documentbyleft-clickingandholdingonthecenterofit;dragittoitsdesiredlocation.More
options,suchasaligningtheimagewithtext(orspecialeffectslikewrappingtextaroundor through
an image) can be found by clicking on the picture, and then choosing the Picture
ToolsTab.Youcanalsoinsertaphotographorotherimagesfromyourfilesusingthissame process.
On the Insert Tab, click on Picture and locate thefiles that you want to include.

ModifyingLine Spacing

LinespacinginWordreferstotheamountofspacebetweenlinesoftext.ThedefaultinWord 2010 is
1.15 spacing, which leaves a little bit more space than single-spacing, or what you
wouldfindinanormalbook.Singlespacingisgenerallyeasyfortheeyetoread.Theremay
betimes,however,whenyouwanttochangethisspacing.Onecommonoptionistodouble- space
text: This text is double-spaced. Double-spacing is especially useful if someone else isproof
readingyourdocument.Itallowsformoreroomtowritecommentsonthepage.

Tochange theline spacing:

1. Selecttextyouwanttoformatbyhighlightingit.

2. OntheHomeTab,clickontheLineSpacingbuttonintheParagraphgroup.
3. Choose the spacing you want from the menu that appears. For more options, select Line
Spacing Options. In the dialog box that appears, you can choose other spacing options,
includingspacingbetweenparagraphs.Thiscanbedonebychangingthevaluesinthebefore and
after boxes.

CreatingBulletedand Numbered Lists

Word allows you to create lists within your document that can be organized with bullets or
numbers.Listsareusefulforpresentingtextthatwouldn’tmakethemostsenseinparagraph
form(forexample,step-by-stepinstructions)orforemphasizingkeypointsBulletsareusually



smallcirclesatthebeginningofiteminalist,andnumbersareusedforliststhatarearranged in
sequential order. Here’s an example of a bulleted list:

• Bananas
• Milk
• Eggs
• IceCream

Tocreatealist:

1. On the Home tab, select eitherthe BulletsorNumberingbuttonsfrom the Paragraph group.
Ifyouwanttochooseaparticularstyleforyourbulletsornumbers,clickonthetrianglenext to the
button and choose a style from the menu that appears.

2. You will see the first bullet or number appear on your document. Type your first line of text
and then hit Enter.

3. Anotherbulletornumberwillappearautomatically.TypeyournextlineoftextandhitEnter.

4. Whenyouhavefinishedyourlist,hitEntertwicetoendthebulletsornumbering.

ChangingViewsandOverall Look

There will be times when you need to create documents that don’t fit on a standard piece of
paper (8.5” by 11”).

ClickonthePageLayoutTab.

From this menu, you can alter the margins, width, height, and orientation (portrait =
11”14long; landscape = 11” wide) of the document, as well as choose from a variety of
templates, different types of paper, and document styles that come with the program. To
change the orientation of your page, clickon the Orientation button.

ClickonLandscapefromthedrop-downboxthatappears.Yourdocumentshouldnowbein
landscapeposition.Ifyouwishtoreturntoportraitorientation,gothroughthesame steps,
clickingon theLandscapeoptioninsteadofPortrait.If youwould like tochangethedisplay
ofyourdocumentorzoominandoutwithoutaffectingthewayyourdocumentwillprint,you
candothatfromtheViewTab.AnythingyouchangefromtheViewTabwillnotchangethe
wayyourdocumentprintsout.Soifyouwantyourtexttobebiggerwhenyouprintoutthe document,
make sure to change the size of the font instead of the zoom.

SpellingandGrammar Check

One benefit of using a computerized word processor is its ability to recognize, change, and
give advice about your writing. MS Word has utilities that can check your spelling and
grammar against a master database, and can offer advice on a variety of different
grammaticalstyles.MS Wordautomaticallyunderlinesanywordsthatitdoesnotrecognize



in red, assuming that they are not spelled correctly, and underlines in green if it does not
recognize the grammatical pattern, assuming that the sentence does not make sense.

Forexample:Inthiscase,“jumping”shouldread“jump”and“laziy”shouldbe“lazy.”Ifyou
rightclickontheword,amenuwithpopupwithoptions,including“Ignore”ifyoudonotwant
helponthisspecificphraseoragreewiththesuggestion.Youcanalsochoosetoaddwords
totheMSWordspellingdatabase,ifyouaregoingtousethemoftenanddon’twantthemto be
flagged as misspelled every time—this is especially useful for names, as MS Word often
interpretstheseasmisspellings.ThespellingandgrammartoolscanbefoundintheReview Tab

USINGMICROSOFTWORD

MicrosoftWord isanexample of a program called a “wordprocessor.”Word processorsare
used to create and print text documents in much the same way that you would use a
typewriter. The keybenefit tousinga word processor is that you can make changes easily,
includingcorrectingspelling;adding,deleting,formatting,andrelocatingtext;andinserting
images. Once you create a document, you can effortlessly print it (as many copies as you
want!), save it for later modifications, or send it to a friend via e-mail. Microsoft Word is a
very powerful word processor-This handout was created using just a small number of its
features!MicrosoftWordisavailableonbothPCsandMacs,sowhatyoulearninclasstoday should
be applicable to any computer you use. The program may look slightly different
dependingontheversionandcomputerthatyou’reusing,butMicrosoftWordwillfunctionin the
same basic ways. There are other word processors out there, including OpenOffice.org
Writer,WordPerfect,ApplePages,andWordPad.Theyhavemanyfeaturesincommonwith
Microsoft Word, and you should feel free to choose any program you prefer.

OpeningMicrosoft Word

To get started with Microsoft Word (sometimes called “MS Word”), you will need to locate
andopentheprogramonyourcomputer.Toopentheprogram,pointtoWord’sicononthe
desktopwithyourmouseanddouble-clickonitwiththeleftmousebutton.If youdon’tsee
theMSWordicononyourdesktop,you’ll have toaccesstheprogram from theStart Menu. Click
on the button in the bottom left corner to pull up the Start Menu. You should see the
MSWord icon here,so clickon itonce withyourleft button.If youstilldon’tseeit,clickon “All
Programs” and scroll through the list of programs until you find it. Click once with your left
button to open the program.
Occasionally, Microsoft Word will be in a folder called “Microsoft Office” or something
similar—this will make one more step between “All Programs” and “Microsoft Word.”MS
Word will then open a blank page called “Document 1.”This is an image of the upper-left
cornerof MSWord.Thisboxfeaturestwoimportantpiecesof information:thenameof the file that
you are currently working on (in this case, “Document 1” since we have not yet renamed it)
and which program you are using (“Microsoft Word”).There should now be a blinking line
in the topleft corner of the part of the screen that looks like a sheet of paper. This means
you will be able to type in this space!

MICROSOFT WORDBASICS



TypingText

Toentertext,typejustasyouwouldifyouwereusingatypewriter.Tocapitalizealetter,hold down the
SHIFT key while typing the letter. Or, press the CAPS LOCK key on the lefthand side of
your keyboard. You will have to press the CAPS LOCK key again—once you
aredonecapitalizing—toremovethelock.YoudonotneedtopressENTERtostartanewline—
Microsoft Word will automatically wrap your sentence at the end of the line. To move the
cursor from its position at the end of your sentence to anywhere else on the page, use the
mouseorthearrowkeystomovethecursorwhereyouwantthelettersorspacestobe(left- click the
mouse to place the cursor) and then type what you want to add—the text will
automaticallyadjust to include it. Press ENTER to starta newparagraph (this is sometimes
called a “carriage return”).

Deleting Text

Whiletypingadocument,sometimesyouwillmakeamistake.Unlikeatypewriter,MSWord can
delete text on thescreen and leave no trace—it is as if you never typed on the page in
thefirst place.There are two different buttons on the keyboard that will allowyou to erase
text. Theyare the “Delete” keyand the “Backspace” key(#s 1 and2 on the keyboardmap on
page.

The“Backspace”keydeleteswordstotheLEFTofthecursor,andthe“Delete”keydeletes words to the
RIGHT of the cursor.

MicrosoftWordFeatures

The Title Bar

Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Itshowsthename
ofthefile(here,“MicrosoftWord”)andthenameoftheprogram(“MicrosoftWord”).Notice the
threebuttonsonthe right side, controllingthe size and closingoftheprogram.

Minimize:Leftclickthisbuttontoshrinkthewindowdowntoasmallbuttonthatwillappearin the task bar

Maximize: Left click this button to make the window as large as it can be—it should take up
your entire screen.
Close:Left-clickthisbuttontoclosethewindow.Theprogramwillcloseandstoprunning.Make sure you
save your work first!

RestoreDown:Left-clickthisbuttontomakethewindowsmallerwithoutminimizingit.

The FileMenu

InMicrosoftOffice2007,therewassomethingcalledtheMicrosoftOfficeButton()inthetop left-
hand corner. In Microsoft Office 2010, this has been replaced with a tab in the Ribbon
called “File.” When you left-click on this tab, a drop-down menu appears. From this menu,



youcanperformthesamefunctionsaswerefoundundertheMicrosoftOfficeButtonmenu, such as:
Create a new document, open existing files, save files in a variety of ways, and print.

TheHomeTab

The most commonly used commands in MS Word are also the most accessible. Some of
these commandsavailable in the HomeTab are: The HomeTabToolbaroffersoptionsthat
canchangethefont,size,color,alignment,organizationandstyleofthetextinthedocument.
Forexample,the“TimesNewRoman”indicatestheFONTofyourtext,the“12”indicatesthe
SIZEofyourtext;etc.Wewillgooverhowtousealloftheseoptionstoformatyourtextina
littlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-clickonthetinydown-arrow in
thebottom right cornerof the window.

The Ruler

The ruler is found below the Ribbon. The ruler tells you where you are on the page, along
withthedimensionsoftheoveralldocument.Justlikearealpieceofpaper,thedefaultsetting
is8.5x11inches,andthemarginshavebeenincorporatedforyou.Similartomostoptions in MS
Word, this is entirely customizable and the user can create a document of any dimensions.

Keyboard Review

In order to use MS Word effectively, you must input commands using both the mouse and
thekeyboard.Theaboveimageofakeyboardshouldlooksimilartothekeyboardinfrontof
you;learningjustafewcertainkeyswillhelptoimproveyourefficiencyintyping,aswellas
presentyouwithmoreoptionswithintheprogram.Thefollowingisalistofcommonlyused
keysthathavespecialfunctionsinMSWord(keyfunctionscanchangedependingonwhich program
you are using)

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.

4. Spacebar:This keyentersa spacebetween wordsorletters.
5. Tab: This key will indent what you type, or move the text to the right. The default indent
distance is usually ½ inch. 6. Caps Lock: Pressing this key will make every letter you type
capitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter:This keyeithergives you a newline, or executes a command(pressed inMSWord,it
begins a new line).



9. NumberKeypad: Theseareexactlythesameasthenumbers atthetopofthekeyboard; some
people just find them easier to use in this position.

10. ArrowKeys: Like the mouse, these keys areused to navigate through a document or
page.

MICROSOFTEXCEL
Microsoft Excel is an example of a program called a “spreadsheet.” Spreadsheets areused
toorganizerealworlddata,suchasacheckregisterorarolodex.Datacanbenumericalor
alphanumeric(involvinglettersornumbers).Thekeybenefittousingaspreadsheetprogram
isthatyoucanmakechangeseasily,includingcorrectingspellingorvalues,adding,deleting,
formatting, and relocating data. You can also program the spreadsheet to perform certain
functions automatically (such as addition and subtraction), and a spreadsheet can hold
almost limitless amounts of data—a whole filing cabinet’s worth of information can be
included in a single spreadsheet. Once you create a spreadsheet, you can effortlessly print
it(asmanycopiesasyouwant!),saveitforlatermodifications,orsendittoacolleaguevia e-mail.
Microsoft Excel is a very powerful.

OpeningMicrosoftExcel
To get started with Microsoft Excel (often called “Excel”), you will need to locate and open
the program on your computer. To open the program, point to Excel’s icon on the desktop
withyourmouseanddouble-clickonitwiththeleftmousebutton.Ifyoudon’tseetheExcel icon on
your desktop, you’ll have to access the program from the Start Menu. Click on the
buttoninthebottomleftcornertopulluptheStartMenu.YoumayseetheExceliconhere, so click on
it once with your left button. If you still don’t see it, click on “All Programs” and scroll
through the list of programs until you find it. It may also be located in a folder called
“Microsoft Office” or something similar—it will depend on your specific machine. Click once
withyourleftbuttontoopentheprogram.Excelwillthenopenablankpagecalled“Book1.”



MicrosoftExcelFeatures

The Title Bar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Itshowsthename
ofthefile(here,“Book1,”thedefaulttitle)andthenameoftheprogram(“MicrosoftExcel”). You will
be able to name your file somethingnew the first time that you save it. Notice the
threebuttonsontherightsideoftheTitleBar,controllingthesizeandclosingoftheprogram.

TheRibbon Menu System
The tabbed Ribbon menu system is how you navigate through Excel and access various
Excel commands. If you have used previous versions of Excel, the Ribbon system replaces
the traditional menus. At the bottom, left area of the spreadsheet, you will find worksheet
tabs.Bydefault,threeworksheettabsappeareachtimeyoucreateanewworkbook.Onthe
bottom,rightareaofthespreadsheetyouwillfindpageviewcommands,thezoomtool,and the
horizontal scrolling bar.

The FileMenu
InMicrosoftOffice2007,therewassomethingcalledtheMicrosoftOfficeButton()inthetop left-
hand corner. In Microsoft Office 2010, this has been replaced with a tab in the Ribbon
called “File.”When you left-click on this tab, a drop-down menu appears. From this menu,
youcanperformthesamefunctionsaswerefoundundertheMicrosoftOfficeButtonmenu, such as:
Create a new worksheet, open existing files, save files in a variety of ways, and print.6
Quick Access Toolbar On the top left-hand side of the Title Bar, you will see several little icons
abovetheFilemenu.Theseletyouperformcommontasks,suchassavingandundoing,without
havingtofindthem ina menu.We’llgo overthemeaningsof theiconsa littlelater.



TheHomeTab
The most commonly used commands in Excel are also the most accessible. Some of these
commands available in the Home Tab are: The Home Tab Toolbar offers options that can
changethefont,size,color,alignment,organizationandstyleofthetextinthespreadsheet and
individual cells. For example, the “Calibri” indicates the FONT of your text; the “11”
indicatestheSIZEofyourtext;etc.Wewillgooverhowtousealloftheseoptionstoformat yourtext in
a little while. Each of these options expands intoa menu if you left-click on the tinydown-
arrowinthebottomrightcornerofthewindow.Thistabworkstheexactsameway
astheMSWordFormattingToolbar.Themaindifferenceisthattheformatchangeswillonly
affecttheselectedcellorcells,allunselectedcellsremaininthedefaultsetting(“Calibri”font, size
“11”).

Equation Editor
The Equation Editor is generally found below the ribbon menu. The left side denotes which
cellisselected(“C5”)andtherightsideallowsyoutoinputequationsortextintotheselected cell.
There are two ways to input information into a cell. You mayeitherselect an individual cell
andtypetheequationortextintotheequationeditorortypetheequationortextdirectlyinto
theselectedcell.Equations(forexample,=SUM(D5+E5))willautomaticallybehiddeninside the
cell and can only be viewed using the equation editor; the result of the equation will
displayinthecell.Ifanywrittentextislongerthanthecellwidth,thenthespreadsheetwill cover up
any portion longer than the cell width. The information will still be in the cell, you just
won’t be able to see it at all times.

Keyboard Review
In order to use Excel effectively, you must input commands using both the mouse and the
keyboard.Theaboveimageofakeyboardshouldlooksimilartothekeyboardinfrontofyou;
learningjustafewcertainkeyswillhelptoimproveyourefficiencyintypingaswellaspresent
youwithmoreoptionswithintheprogram.Thefollowingisalistofcommonlyusedkeysthat you may
already be familiar with:
1. Backspace:Thiskeydeleteslettersbackwards.
2. Delete:Thiskeydeleteslettersforward.
3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.
4. Spacebar:This keyentersa spacebetween wordsorletters.
5. Tab: This key willindentwhatyoutype,or movethetexttothe right.Thedefault indent distance
is usually ½ inch.

6. CapsLock:Pressingthiskeywillmakeeveryletteryoutype capitalized.
7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.
8. Enter:Thiskeyeithergivesyouanewline,orexecutesacommand.
9. NumberKeypad: Theseareexactlythesameasthenumbers atthetopofthekeyboard; some
people just find them easier to use in this position.

10. ArrowKeys: Like the mouse, these keys areused to navigate through a document or
page.



Pointer Shapes
AswithotherMicrosoftprograms,thepointeroftenchangesitsshapeasyouworkinExcel. Each
pointer shape indicates a different mode of operation. This table shows the various pointer
shapes you may see while working in Excel.

MICROSOFTEXCEL BASICS

Formatting Cells
Cells are the small rectangular boxes that make up the spreadsheet. All the information
enteredintoanExcelspreadsheetisenteredintocells.Thecellwidthandheightwillusually need to
be adjusted to viewall the information entered into a cell.

Toadjustthecellwidth,movethemousepointerinbetweentwocellcolumnsinthecolumn
header.Holddowntheleftmousebuttonanddragthemouselefttoshortenthewidthorright
toexpandthewidth.Noticethatallcellswithinthecolumnareautomaticallyadjusted.Adjust
thecellheightusingthesamemethod.Movethemousecursorbetweentworows,holddown
theleftmousebuttonandmovethemouseuptodecreasetheheightanddowntoincrease the height.
Before you begin entering data into a spreadsheet, you may already know the
widthandheightyouwantyourcellstohave.Inthiscase,youcanadjustallthewidthsand heights by
doing the following: Select the “square” between Column A and Row 1.

This will select ALL the cells in the spreadsheet. From the “Home” tab of the Ribbon Menu,
within the “Cells” box, click on “Format,” and select Row Height. You will now be asked to
enteranumericalvalueforheight.Thedefaultvalueis15,butyoucanenteryourownheight value
(10, 20, 25, etc.).

Repeat the samesteps forColumn width. From the “Home”tabof the Ribbon Menu, within
the “Cells”box, click on “Format,” and selectColumnWidth. Note that the default valuefor
thewidthis8.43.Enteryourown widthvalue(5,10,15,20,etc.).

Foranygivencellorselectedcells,youcanalsoformatthewayyourdataisrepresentedwithin the cell(s).
Select a single cell or multiple cells.
Again, from the “Home” tab of the Ribbon Menu, within the “Cells” box, click on Format.”
Select“FormatCells.”Theformatwindowwillnowappear,givingyouawidevarietyofoptions on how
to format your cell.

Number –Thisallowsyoutochoosehowtorepresentthenumbersthatareenteredintoacell (number,
currency, time, etc.).
Alignment–Thisdetermineshowthedatawillbealignedwithinthecell(left-side,centered,or right-
side).
Font–Selectthetypeoffonttobeusedwithinthecells.
Border–Thisoptionletsyouchoosewhattypeofborder,ifany,youwouldlikearoundthecells or some of
the cells.
Fill –Thisallowsyoutochangethebackgroundcolorofthecell.



Protection – This option allows you to “lock” cell information so that otheruserscannotmake
changes.

TypinginCells
Click on a cell to begin typing in it. It is thateasy!When you arefinished typing in the cell,
press the Enter key and you will be taken to the next cell down. You can then begin typing
in that cell. You can easily navigate around the cells using your arrow keys. Keep in mind
that the Formatting toolbar in Microsoft Excel 2010 is exactly the same as the one used for
MicrosoftWord2010.Thebiggestdifferencebetweenthetwoprogramsisthat,inExcel,the format
is set for each individual cell.

SoifyouchangethefontandappliedtheboldoptionincellC5,thenthisformatwillonlybe applied to
cell C5. All remaining cells will remain in default mode until they have been changed.
Sometimes you may only wish to adjust the format of one particular cell. In this
case,simplyselectthecellbyclickingthemouseonitandmakeanynecessaryadjustments to the
font, size, style, and alignment. Those changes will not carry over when you begin
typinginanewcell.Othertimes,youmaywishtoadjustthetextformatofagroupofcells, entire rows,
or entire columns.

In Excel, you can choose groups of cells in rectangular units—all the
cells you select must form a rectangle of some kind. To select a group of cells, begin by
clickingonthecellthatwouldbeintheupper-lefthandcornerofyourrectangle.Holddown
theShiftkeyonyourkeyboardandusethearrows(←,→,↑,↓)onthekeyboardtoexpand the
selection of cells, or click and drag your mouse. Once the group of cells has been selected,
you canmake adjustments to thefont, size, style, and alignmentandtheywill be applied to all
selected cells.

Toselectanentirerow,clickontheRowNumberwithyourmouse—notehowtheentirerow
becomeshighlighted.Allformattingchangeswillnowbeappliedtothewholerow.Toselect an
entire column, click on the Column Number with your mouse—again, the entire column will
become highlighted. Allformatting changes will be applied to the whole column.

InsertingRowsand Columns.
Whenyouareworkingonaspreadsheet,youmayrealizethatyouleftoutaroworcolumn of
dataandneed to add it in.To inserta row, click on the rowbelow where you want your
newrowtobe(remembertoclickontherownumbertohighlighttheentirerow).Fromthe “Home”
tab, within the“Cells” box, click “Insert.” Select

“Insert Sheet Rows.” A new row will automatically be inserted and the row numbers
automaticallyadjusted.Toinsertacolumn,clickonthecolumntotherightofwhereyouwant
yournewcolumntobe(remembertoclickonthecolumnlettertohighlighttheentirecolumn).
Fromthe“Home”tab,withinthe“Cells”box,click“Insert.”Select“InsertsheetColumns.”A new
column will automatically be inserted and the column letters automatically adjusted.

SortingData



Once you have created your spreadsheet and entered in some data, you may want to
organizethedatainacertainway.Thiscouldbealphabetically,numerically,oranotherway. Let’s
look at the following spreadsheet as an example. This information can be sorted by check
number, date, alphabetically by description, or using any of the other columns.

First,selectallthecellsthatrepresentthedatatobesorted,includingtheheaderdescriptions (Check
No., Date, Description, etc.). Then, select the first cell in Row 1 (Check No.) Click and drag
to select all the cells that you want to sort. Using the mouse, select Sort & Filter from the
Editing panel. Select Custom Sort…
Select the column you wish to sort by. Do you want to sort by alphabetical order, reverse
alphabeticalorder,date,oramount?Whenyoupress“OK,”yourspreadsheetwillbe sorted in the
order that you specified.

AutoSumandExcelEquations
One of the most powerful features of Excel is its ability to perform basic math functions on
data. Excel can add, subtract, multiply, divide, find the average, and perform general
countingfunctionsonthenumericaldatathatyouenter.Toenablethisfeature,highlightall of the
cells in a column, plus one additional emptycell in which to displaythe result.

SelecttheAutoSumiconfromtheribbonmenu:
Ifyouclickdirectlyonthe∑,Excelwillautomaticallyaddupthenumbersyouhaveselected. If you
click on the little dropdown arrow next to it (▼), you will get the full choice of
mathematicalfunctions.Ifyoudouble-clickonthecellinwhichtheanswerappears,youwill
seeanequationthatlookssomethinglikethis(youwillalsoseethisequationintheEquation Editor):
Let’sbreakdownwhatexactlytheequationmeans:
=indicatesthatyouarestartinganequationinthiscell.
SUMtellsthefunctiontobeperformed.Inthiscase,allthecellswillbeaddedtogether.
( )Theparentheses containthecells that thefunction will be performedon.
D2thisisthefirstcelltobeincludedintheadditionformula.
D8thisisthelastcelltobeincludedintheadditionformulaindicatesthatallcellsbetweenthe first and the
last should be included in the formula.
The spreadsheet will often “select” the cells that it thinks you wish to include. But you can
manually change the cell range by typing into the Equation Editor. When you are ready to
execute the formula, just press the “Enter” key. Other mathematical functions you can
perform from the AutoSum button include:
Average – This function will calculate the average of the selected cells.
CountNumbers–Thisfunctionsimplycountsthenumberof cellsselected. Max –
This function will return the highest value of the selected cells.
Min–Thisfunctionwillreturnthelowestvalueoftheselectedcells.
*Remember*Excelequationsaresimilartoprogramminglanguages,sohavesomepatience
andifatfirstyoudon’tsucceed,tryagain.EvenExcelprofessionalscreateincorrectformulas on
their first try.
Onceyougetanequationtowork,youwilltechnicallybeacomputerprogrammer! Creating Charts
and Graphs:
InExcel,therearealsowaystorepresentyourdatainchartorgraphicalforms.



To create a chart or graph, select the Insert tab from the Ribbon Menu bar. In the middleof
this new menu, you will see a “Charts” box.
1. Selecttherangeofdatatoberepresentedinthechartorgraph.Clickonyourspreadsheet and
select the data to be represented using the same method that you used to select data in
the sorting exercise. For this example, we want to see a visual comparison of how much
money we spent on each item in the list. Select rows 1 through 8 in rows B, C, and D.
2. Select thetype of chart orgraph you wish tocreate (forourexample, we’ll choose a bar
graph).
3. Once you have created your graph, you can now “customize” it by giving it a title and
labeling different parts. You can also make certain design decisions regarding the
appearanceof yourgraphorchartbychoosingthedifferentelementsundertheDesigntab that
appears on the Ribbon Menu bar.
4. Finally, you will need to decide if your chart should be pasted on to the existing
spreadsheetorifitshouldbepastedontoabrandnewsheet.Ontheveryrightsideof the Ribbon
Menu bar, select Move Chart. Once the chart or graph has been created and you
realizeamistakehasbeenmadeoritdidnotturnoutthewayyouwanteditto,simplyclick on the
chart or graph and hit the Backspace key on your keyboard to delete it from your
spreadsheet. Don’t be afraid to go back and try again!

Multiple Sheets

Sometimesyoumayfinditusefultohavemultiplespreadsheetsforrelateddata.Forexample,
personalfinances are usually trackedon a monthlycalendar and it’s generallygood idea to
keeprecordsofthepasttransactions.Excelcancreatemultiplespreadsheetsattachedtothe
sameExcelfile,oneforeachmonth.Tabsforthedifferentsheetsarelocatedinthelower-left corner of
the spreadsheet. The spreadsheet that is currently being worked on is on the top
tab.Toaccessanotherspreadsheet,selectthe appropriatetab,suchasSheet2.Thedefault
namesforthesheetsareusuallySheet1,Sheet2,andSheet3.Torenameasheetortocreate a new
sheet, simply move the mouse pointer over the sheet name and right-click. Select “Rename”
to rename the sheetor select “Insert” to create a newsheet.

Youcantransfercellinformationbetweentwoormoresheetsbycreatingasimpleformula.
Forexample,mostpeoplewhokeeptrackoftheirpersonalfinancesdon’tbegineverymonth
withabalanceof$0.Instead,thebalanceatthebeginningofthemonthistransferredover from the
previous month. So if you have a March 2012 finance spreadsheet and an April 2012
finance spreadsheet, you can select a cell in the April 2012 sheet and write in the formula

=‘March2012’! D11
The equals sign (=) tells Excel thatthe value for this cell is to be derivedfrom somewherein
the spreadsheet (such as a formula or another cell location).
‘Sheet name’ tells Excel what sheet to refer to when it retrieves the value. The single
quotationmarks(‘‘)areimportant.!D11tellsExcelthatitistocopythevaluethatislocated in cell D11
(or whatever cells you wish to copy the value from).
Ifyouwanttotransfercellinformationfromonecelltoanotheronthesamesheet, youcanuse the exact
same formula; just exclude ‘Sheet name.’



DOINGMOREWITHMICROSOFTEXCEL

Cutting,Copying,andPastingData
When you are typing in your spreadsheet, it can be very helpful to cut or copy information
fromonecellandpasteitintoanother.Thiscanhelpreducetheamountoftypingyouhave
todo,aswellaslimitthenumberof typographicalerrors.Cutting,copying,andpastingthe contents
of cells in Excel is very similar to the way you do it inMicrosoftWord.
ThesecommandsareallaccessiblefromtheHometabontheRibbonMenubar.
ToCUTthecontentsofacell,clickonthecelltoselectit,thenclickontheCutbuttononthe
Hometab.Youwillseetheborderofthecellturnintolittle“marchingants.”Thecontentsare now on
the Clipboard, ready for you to paste them somewhere else.

ToPASTEthecutselectionsomewhereelse,clicksonthecellwhereyouwanttheselection
togo.ThenclickonthePastebuttonontheHometab.Theselectionwillnowappearinthe new cell
and be removed from the original cell.

To COPY the contents of a cell, simply follow the directions above but replace the CUT
command with COPY. This will leave the contents of the original cell in place and make an
exact copy of them in another cell.

FillingDataacrossColumnsand Rows
Anotherwaytocopytextfromonecelltoanotheristodragitor“fill”itacrossarangeofcells
(aroworacolumn).Thisisagreatmethodifyouwantallthetext(ornumbers)incolumnor row to be
the same. For example, if you have a spreadsheet for your yearly budget with a column for
rent, you could use this method to fill in all the cells in the rent column with the same
number without re-typing.

Tofillthecontentsofcellsinacolumn:
1. Clickonthecellwiththeinformationyouwanttocopytotheothercells.
2. Hoveryourmouseoverthelittlesquare(calleda“fillhandle”)inthebottomrightcornerof the
highlighted cell border. Your mouse will turn into a cross.

3. Clickonthefillhandleanddragyourmouse(whilestillholdingthebuttondown)downthe
columnuntilyou’vehighlightedallthecellswhereyouwantthetexttogo.4.Letgoofthe mouse
button. The text will nowappear in all the cells you highlighted.

5. You can follow these same steps to fill the contents of a row rather than a column— simply
drag your mouse across the row instead of down the column.
Youcanalsousethistechniquetocopyformulasacrosscolumnsandrowsinthespreadsheet.

CLOSINGMICROSOFTEXCEL



SavingSpreadsheets

When you finish your spreadsheet and want to leave the computer, it is important to save
yourwork,evenifyouareprintingahardcopy.TosaveyourworkinExcel,itisessentialto know
WHAT you are trying to save and WHERE you are trying to save it.
ClickontheFileTab,thenclick“Save As” togetstarted.Youcanchangethefilenamethat
Excelhaschosenjustbytypinganewoneinthe“Filename”boxatthebottomofthewindow that
appears. The My Documents folder on your computer’s hard drive is a good place to store
your documents. A blank CD or a USB jump drive are great portable storage options and
can contain a LOT of data. Excel will automatically save your document with the suffix
“.xlsx”–thisissimplyatagthatletsExcelknowthatyourworkisspecifictothisprogramand
whatversionitisin.Youdonothavetotypeit–justhighlightwhatisthere(defaultis“Book1”)
andwriteanewfilename.Youmayalsochosetosaveitinanolderformatsothatitcanbe
openedwitholderversionsofExcel.Afterthefirstsave,youcanjustclick“Save”topreserve your
work.

However, it is important to note that every following command of SAVE will overwrite your
originalfile,creatingthemostup-to-date version.Ifyouwouldlike to keep savingdifferent
versionsofyourworksheet,besuretousethe“SaveAs”functioneachtimeyousave,using a slightly
different name for each version.

Printing Spreadsheets
ToprintyourExceldocument,clickontheFileTab,thenclick“Print”from theleft-sidecolumn. A Print
Preview and printing options will appear in your Excel window.
Click the large “Print” button to send your worksheet to the printer. You can change the
numberofcopiesyouwouldliketoprint,changethepaperorientation,choosewhichprinter you
want to use, and more.

Finding More Help
YoucangethelpwithExcelbyclickingontheQuestionMarksymbolintheupper-righthand
cornerofthemainmenubarorbypressingthe“F1”button.Thiswilltakeyoutohelpfrom Office.com,
Microsoft’s help website. There are also many other resources and tutorials
availableonline.YoumighttryaGooglesearchwiththewords“Excel2010”andthefunction
youaretryingtoperform.Askyourinstructorforhelpfindingtheseresourcesifyouhaveany trouble.

Closing the Program
ClickontheFileTab,thenclick“Exit.” OR
ClickontheXinthetoprightcorneroftheExcelscreen.

MICROSOFTPOWERPOINT



Microsoft PowerPoint is a professional presentation program that allows the user to create
"presentation slides" that can be displayed on the computer screen or through a projector
thatispluggedintothecomputer.APowerPointpresentationisagoodwaytoconveypieces of
information,usuallyin theform of an outline, toa large audience.Generally, PowerPoint
presentationsareappealingtousersbecausetheyareeasytocreateandeditandgenerally
smallenoughtofitontoaCDoraUSBJumpDrive.Therefore,auserdoesnothavetocarry around
anyslides or a slide project, and, if necessary, can make lastminute changes to the
presentation.

MicrosoftPowerPointComponents:

Before you get started with Microsoft PowerPoint (commonly referred to as PowerPoint), you
willneedtolocateandopenitonthecomputer.Itmaybeonyourdesktop.
Onthecomputerdesktop:
1.Double-clickonthe MSPowerPointicon
IftheMSPowerPointiconisnotonthedesktop,gototheStartmenu:
1. Click►Start►Programs►Microsoft PowerPoint*
MSPowerPointwillopenablankpagecalled"Presentation1."



TheTitleBar
This is a close-up view of the Title Bar, where file information is located. Notice the default
title"Presentation1."Youwillgetachancetorenameyourpresentationslidesthefirsttime you
choose to save it.

TheMenu Bar
TheMenuBarisacommonsightinalmostallMicrosoftWindowsprograms.Itfeaturestext based
menus, on which virtually every option available to the user in the entire program is listed.
Each menu expands when clicked (with the left mouse button), offering many options
categorized by specific tasks.

Standard Toolbar
Toolbarsprovide"shortcuts"tocommandsalsofoundintheMenuBar.Toolbarsareusually located
justbelowtheMenu Bar and exist tooffer another wayto perform the same task.
The most commonly used commands in MS PowerPoint are also the most accessible.
Some of these commands are:
New|Open |Save| Print| Preview|Spell-check|Copy|Paste|Undo| Insert

Formatting Toolbar
The Formatting Toolbar offers options that can change the font, size, color, alignment,
organization,andstyleofthetextinthepresentationslides.Forexample,(startingfromthe left side
of the Toolbar) the "Arial" indicates the FONT of your text; the "32" indicates the SIZE of
your text; and so on. This toolbar works the exact same way as the MS Word
FormattingToolbar.The main difference is that theformat changes willonlyaffect the text
box in which you are currently working.
Allothertextboxeswillremaininthedefaultsetting("Arial"font,size"32").Design/NewSlide Icons
additional shortcut icons appear on the MS PowerPoint toolbar: the Design icon and the
New Slide icon. Both commands are frequently used, and it is good to be familiar with their
location on the toolbar.

The Design icon is a shortcut to the slide design page. Here you will be
able to create and edit the appearance of your slide(s). The New Slide icon automatically
addsanew,blankslideforyoutoworkon.Youcankeeptrackoftheslidesyouhavealready worked on
in the Slide Outline box on the left-hand side of the screen. You can access a slide at any
time by clicking on it with your mouse through this screen.

SIMPLETASKSINMICROSOFTPOWERPOINT
Text Boxes:
TextBoxesare"designated"areasthatallowyoutotypewords,sentences,andbulletpoints into the
slide. You canadjustthesize andplacementof thetext box within anygiven slide. It is also
possible to have multiple text boxes per slide.

WhenyoufirstopenMSPowerPoint,therewillautomaticallybetwotextboxesontheslide:

"Clicktoaddtitle"and"Clicktoaddsubtitle."Thesetextboxesalreadyhaveapresetformat
appliedtothem.The"title"boxhasafontsizeof"44"whilethe"subtitle"boxhasafontsize



of"32."Youcanchangethetextformatofanyboxatanytimebyadjustingtheformatsettings
ontheFormattingToolbar.Toadjustthesizeofthetextbox,firstclickonthetextbox.Notice the
change in border. Once you have clicked on a text box, the border of the box becomes
thicker and little circles appear on the corners and at the midpoints of the box. Move the
mousepointeroveranyoneofthecircles.Noticethatthemousepointerwillchangetoeither
↔or↕.Clickandholddowntheleftmousebutton.Toadjusttheheight,movethemouseup
ordown;toadjustthewidth,movethemouseleftorright.Notethatthecornercirclescan
adjustbothheightandwidth,whilethemid-pointcirclescanonlyadjusteitherheightorwidth.

Tomovethetextboxtoadifferentlocationontheslide,moveyourmousepointeroverany part of the
thick, gray box outline. Notice the change in your mouse pointer (it will look something like
a "plus" sign (+) with arrows). Click and hold down the left button on your mouse. You can
now drag the text box to any position on the slide by simply moving your
mouse.Towriteinatextbox,simplyclickinsidetheboxwithyourmouse.Whenacursoris flashing,
you are ready to type.

Slide Design:

OneofthemorepopularfeaturesofMSPowerPointisthatitgivestheuseawidevarietyof design
choices. At some point, you may wish to change the design and color of the
backgroundofyourslides.Todoso,simplyclickontheDesignicon.Ontheright-handside
ofyourscreen,the"SlideDesign"panewillappear.Here,youaregiventhreedesignoptions to apply
to your slides.

Design Templates:Hereisalistofover20templatesthatyoucanchoosefromtoapplyto
thebackgroundofyourslides.Foreachtemplate,youhavetheoptionofapplyingthedesign
toallslidesortoonlytheselectedslide.Youcanviewtheseoptionsbyclickingonthearrow
ontherightsideofthetemplate.IfyouareconnectedtotheInternet,youcanalsochoose
toviewhundredsofadditionaltemplatesbychoosing"DesignTemplatesonMicrosoftOffice
Online" on the bottom of the template screen.

Color Schemes:Thisoptiongivesyoua varietyof colorschemestochoosefrom toapplyto your
selected design template.

Animation Schemes: This option will allow you to select different types of animation that
canbeappliedtoeitheralltheslidesorselectedslides.Theanimationschemesaredifferent ways
the slides are "introduced" to your audience, such as "faded wipe" or "pinwheel."

Designingyour ownbackground:

Sometimesyoumaywishtodesignyourownbackground.



To do this, select Format ► Background… from the Menu Bar. Select the Color Bar on the
bottomoftheBackgroundwindowandchoosetheappropriatecolorandor/effectsthatyou
desire.Thereisnorightorwrongwaytodesignyourownbackground,soifyouchoosethis option,
have some patience and don't be afraid to experiment.

Slide Layout:

The default in PowerPoint for each new slide is to have a Title text box and a Text box. As
discussedearlier,youdohavetheoptionofrearrangingthetextboxestofitanylayoutyou have in
mind. However, sometimes it will be easier simply to select a layout that fits your needs
rather than reformatting the default layout for each slide. To choose a slide layout,
selectFormat►SlideLayoutfromtheMenuBar.Ontheright-handsideofyourscreen,the "Slide
Layout" pane will appear. From here, you have the option of applying a slide layout either
to a selected slide or to a new slide that has yet to be inserted. You can view these
optionsbyclickingon the arrowon the right side of the template.

Notethefourdifferenttypesoflayout categories.

TextLayout: Theseoptionsareforchoosingalayoutinwhichyouareonlyorganizingdifferent text
boxes. There is no room for pictures, charts, or graphs.

ContentLayout: Theseoptionsareforchoosingalayoutthatwillonlycontainpictures,charts, or
graphs. There is no room for text boxes.

TextandContentLayout:Theseoptionshaveroomforbothtextboxesandpictures,charts,or graphs.

OtherLayouts:Theselayoutsaredesignedforothermediacontentsuchasvideoclipsoraudio tracks.

Inserting a Picture:

InsertingapictureintoMSPowerPointisverysimilartoinsertingapictureintoMSWord.

1. Selecttheslidethatyouwishtoaddapictureto.

2. FromtheMenuBar, selectInsert►Picture►FromFile(orClip Art).

3. Choosethepictureyouwishtoinsertandselect"Insert."

*Note*: Thepicturewillbeinsertedinitsoriginalsize,soyouwillprobablyhavetore-sizeit.
Youcanre-sizeapicturethesamewayyoure-sizedatextbox.Clickonthepictureandnote the circles
at the corners and at the midpoints of the length and width. Move your mouse pointer over
the circles, left-click the mouse and hold the button down. Move the mouse vertically or
horizontally to re-size.



Rotating a picture: It is possible to rotate pictures in MS PowerPoint. Once a picture has
been inserted ontoa slide and you have clicked on the picture so itis"outlined," notice the
green circle above the center of the picture.

Movethemousepointeroverthegreencircleandleft-clickandholdthebuttondown.Now
movethemouseeitherclockwiseorcounter-clockwiseandthepicturewillrotateinthesame
direction.

Inserting aGraph or Table:

TherearetwowaystoinsertagraphortableintoaPowerPointslide.

1. Thegraphortablemayalreadyexistinanotherdocumentorfile.Ifthisisthecase,then
youcansimplyinsertthegraphortableasyouwouldapicture.Followtheinstructionsunder
Inserting a Picture.

OryoucouldCutandPasteagraphorchartfromanotherdocumentorfileintoyourslide presentation.

2. MSPowerPointcancreategraphsortablesdirectlyintheslide.FromtheMenuBar,select

Insert►Chart(orTable).

FortheChartoption,PowerPointwillpresentaverysimplebargraph.

Youwillneedtogoinandedittheinformationinthebargraphtoconformtotheinformation
youwishtorepresentinachart.FromtheDatasheet,youcanenterintheappropriatevalues for the
columns and re-name the entities.

TheTableoptionwillpresentyouwiththefollowingwindow:

Select the appropriate number of rows and columns you wish to have in your table. Click
"OK"toinsertthetable.Oncethetablehasbeeninsertedyouwillbeabletoputinformation into the
table cells.

Slide Management:

Once you have completed a slide, you can create a new slide by clicking on the New Slide
icon.Noticethatyourpreviousslidesstillappearontheleft-sideframe.Youcanstillaccess your
previous slides by simply clicking on them from this location.

Once all your slides have been completed, you can present your slides in a "slideshow."
From the Menu Bar select Slide Show► View Show. Notice that the slide takes over our
entire screen. To navigate through the slides, use the arrow

keysonyourkeyboard(←,→or↑,↓).Youcanalsonavigatethroughyourslidesbyclicking
ontheleftorrightarrowsinthelowerleftcornerofyourslide.Toendyourslideshow,click



on the square box on the lower left side of your slide show (this is difficult to see at first
because it is designed to blend into you slide show so it won't be noticeable to your
audience). Select End Show from the pop-up window.

CLOSINGMICROSOFT POWERPOINT

SavingSlideShows:

Whenyoucometoastoppingpointandwanttoleavethecomputer,itisimportanttosave your work
(even if youare printinga hard copy — saving should bea reflex). To save your work in MS
PowerPoint, it is essential to know WHAT you are trying to save as well as WHERE you are
trying to save it.

Click►File ►Save fromthe Menu Bartogetstarted.
You can change the filename that PowerPoint has chosen just by typing a new one in the File
name box at the bottom of the windowthat appears.

MSPowerPointwillautomaticallysaveyourdocumentwiththesuffix“.ppt”–thisissimplya
tagthatletsPowerPointknowthatyourworkisspecifictothisprogram.Youdonothaveto typeit–
justhighlightwhatisthere(defaultis“Presentation1”)andwritea newfilename.

The My Documents folder on your computer’s hard drive is a good place to store your
documents. A blank CD (compact disc) or a USB Jump Drive are great portable storage
devices and can contain a LOT of data. It is important to note that every consequent
command of SAVE will overwrite your original file, creating the most up-to-date version. If
youwanttosaveanychangestoyourPowerPointslideswithoutdestroyingtheoriginalone:

In the Menu Bar, click ►File ►Save As from the menu bar and give your document a new
filename(uniquefromtheoriginal).Tobringasaveddocumentbackuponthescreenfrom MS
PowerPoint:

Click ►File ►Open from the Menu Bar.Locate where the file islocated (which folder,that is) and
click on the filename of the document you want.

Click ►Open.

PrintingSlides:

Toprint your MS PowerPointslides:

Click►File►PrintfromtheMenuBarandaPrintwindowwillpopuponthescreen. Click ►OK

for your document to start printing.

As with all commands in MS PowerPoint, you can make changes along the way. From the
Printmenu,youcanalterhowmanycopieswillbemade,inwhatorderthepageswillbe,



andmuchmore. Otheruseful tools arethe Print Previewfunctionfoundalongside the Print
command and the

PageSetup function.PrintPreviewwillallowyoutolookoveranexactcopyofwhatwillcome outof
theprinter before actuallyexecutingthe print command.

Closing the Program:

Whenyouarefinished,

Click►File►ExitfromthemenubarOR

ClickontheXinthetoprightcornerofthecomputerscreen.
Introduction:

Theinternetinsimpletermsisanetworkoftheinterlinkedcomputernetworkingworldwide, which
is accessible to the general public. These interconnected computers work by
transmittingdatathroughaspecialtypeofpacketswitchingwhichisknownasthe IPorthe internet
protocol.

Internet is such a huge network of several different interlinked networks relating to the
business,government,academic,andevensmallerdomesticnetworks,thereforeinternetis
known as the network of all the other networks. These networks enable the internet to be
usedforvariousimportantfunctionswhichincludetheseveralmeansofcommunicationslike
thefiletransfer,theonlinechatandeventhesharingofthedocumentsandwebsitesonthe WWW, or
the World Wide Web.

ItisalwaysmistakensaidthattheinternetandtheWorldWideWebareboththesameterms,
oraresynonymous.Actuallythereisaverysignificantdifferencebetweenthetwowhichhas to be
clear to understand both the terms. The internet and World Wide Web are both the
networks yet; the internet is the network of the several different computers which are
connectedthrough thelinkage of the accessorieslike the copperwires, thefiberopticsand
even the latest wireless connections. However, the World Wide Web consists of the
interlinked collection of the information and documents which are taken as the resource by
thegeneralpublic.ThesearethenlinkedbythewebsiteURLsandthehyperlinks.Therefore
WorldWideWeb isone ofthe servicesoffered bythewholecomplicatedandhuge network
oftheinternet.TheuseofIPintheInternetistheintegralpartofthenetwork,astheyprovide
theservicesoftheinternet,throughdifferentlayersorganizationthroughtheIPdatapackets.
Thereareotherprotocolsthatarethesub-classesoftheIPitself,liketheTCP,andtheHTTP.

Bytheturnofthecentury,information,includingaccesstotheInternet,willbethebasisfor personal,
economic, and political advancement. The popular name for the Internet is the information
superhighway. Whether you want to find the latest financial news, browse through library
catalogs, exchange information with colleagues, or join in a lively political debate, the
Internet is the tool that will take you beyond telephones, faxes, and isolated computers to
a burgeoning networked information frontier.



TheInternetsupplementsthetraditionaltoolsyouusetogatherinformation,DataGraphics, News
and correspond with other people. Used skillfully, the Internet shrinks the world and
bringsinformation,expertise,andknowledgeonnearlyeverysubjectimaginablestraightto your
computer.

WhatistheInternet?

TheInternetlinksarecomputernetworksallovertheworldsothatuserscanshareresources
andcommunicatewitheachother.Somecomputershavedirectaccesstoallthefacilitieson the
Internet such as the universities. And other computers, example privately-owned ones,
have indirect links through a commercial service provider, who offers some or all of the
Internetfacilities.InordertobeconnectedtoInternet,youmustgothroughservicesuppliers.
Manyoptionsareoffered with monthlyrates.Dependingonthe option chosen,accesstime may
vary.
TheInternetiswhatwecallaMetanetwork,thatis,anetworkofnetworksthatspanstheglobe. It's
impossible to give an exact count of the number of networks or users that comprise the
Internet,butitiseasilyinthethousandsandmillionsrespectively.TheInternetemploysasetof
standardized protocols which allow for the sharing of resources among different kinds of
computers that communicate with each other on the network. These standards, sometimes
referredtoastheInternetProtocolSuite,aretherulesthatdevelopersadheretowhencreating new
functions for the Internet.
The Internet is also what we call a distributed system; there are no central archives.
Technically,noonerunstheInternet.Rather,theInternetismadeupofthousandsofsmaller
networks. The Internet thrives and develops as its many users find new ways to create,
displayandretrievetheinformationthatconstitutestheInternet.

Who OwnstheInternet?
NooneactuallyownstheInternet,andnosinglepersonororganizationcontrolstheInternet
initsentirety.TheInternetismoreof aconceptthananactualtangibleentity,anditrelies on a
physical infrastructure that connects networks to other networks.

Is WebandInternetthe Same?
TheInternetisnotsynonymouswithWorldWideWeb.TheInternetisamassivenetworkof networks,
a networking infrastructure. It connects millions of computers together globally,
forminganetworkinwhichanycomputercancommunicatewithanyothercomputeraslong
astheyarebothconnectedtotheInternet.TheWorldWideWeb,orsimplyWeb,isawayof accessing
information over the medium of the Internet. It is an information-sharing model
thatisbuiltontopof theInternet.

WEBBROWSER:

Awebbrowser(commonlyreferredtoasabrowser)isasoftwareapplicationforretrieving,
presenting, and traversing information resources on the World Wide Web. An information
resourceisidentifiedbyaUniform ResourceIdentifier(URI/URL)andmaybe awebpage, image,
videoorotherpiece of content. Hyperlinks present inresourcesenableuserseasily to navigate
their browsers to related resources.

AlthoughbrowsersareprimarilyintendedtousetheWorldWideWeb,theycanalsobeused to access
information provided by web servers in private networks or files in file systems.



Usesof Internet

Internetistodayoneofthemostimportantpartofourdailylife.Therearelargenumbersof
thingsthatcanbedoneusingtheinternetandsoitisveryimportant.Youcansaythatwith the progress
in the internet we are progressing in everysphere of life as it notonlymakes our tasks easier
but also saves a lot of time. Today internet is used for different purposes
dependingupontherequirement.Hereinthisveryarticlewehavementionedthentenbest uses of
the internet. Here goes the list.

1) Email:

By using internet now we can communicate in a fraction of seconds with a person who is
sittingintheotherpartoftheworld.Todayforbettercommunication,wecanavailthe facilities of
Email. We can chat for hours with our loved ones. There are plenty messenger services and
email services offering this service for free. With help of such services, it has
becomeveryeasytoestablishakindofglobalfriendshipwhereyoucanshareyourthoughts, can
explore other cultures of different ethnicity.

2) Information:

Thebiggestadvantagethatinternetofferingisinformation.TheinternetandtheWorld
WideWebhasmade iteasyfor anyone toaccess information and itcanbeof anytype, as
theinternetisfloodedwithinformation.TheinternetandtheWorldWideWebhavemadeit
easyforanyonetoaccessinformationanditcanbeofanytype.Anykindofinformationon any topic
is available on the Internet.

3) Business:

Worldtradehasseenabigboomwiththehelpoftheinternet,asithasbecomeeasierfor buyers and
sellers to communicate and also to advertise their sites. Now a day's most of the people
are using online classified sites to buy or sell or advertising their products or



services. Classified sites save a lot of moneyand time so this is chosen asmedium bymost
of people to advertise their products. We have many classified sites on the web like
craigslist, Adsglobe.com, Kijiji etc.

4) SocialNetworking:

Todaysocialnetworkingsiteshavebecomeanimportantpartoftheonlinecommunity.Almost all users
are members use it for personal and business purposes. It's an awesome place to network
with manyentrepreneurs who come here to begin building their own personal and business
brand.
5) Shopping:

In today's busylife most of us are interested to shop online. Nowa day's almost anything
canbeboughtwiththeuseoftheinternet.IncountrieslikeUSmostofconsumerspreferto shop
from home. We have many shopping sites on internet like amazon.com, Dealsglobe.com
etc. People also use the internet to auction goods. There are manyauction sites online,
where anything can be sold.

6) Entertainment:

Oninternetwecanfindallformsofentertainmentfrom watching filmstoplayinggames online.
Almost anyone can find the right kindof entertainmentfor themselves.When
peoplesurftheWeb,therearenumerousthingsthatcanbefound.Music,hobbies,news
andmorecanbefoundandsharedontheInternet.Therearenumerousgamesthatmay be
downloaded from the Internetfor free.

7) E-Commerce:

Ecommerce is the concept used for any type of commercial maneuvering, or business
dealsthatinvolvesthetransferofinformationacrosstheglobeviainternet.Ithasbecome a
phenomenon associated with any kind of shopping, almost anything. It has got a real
amazing and range of products from household needs, technology to entertainment.

8) Services:

Many services are now provided on the internet such as online banking, job seeking,
purchasingticketsforyourfavoritemovies,andguidanceservicesonarrayoftopicsinthe every
aspect of life, and hotel reservations and bills paying. Often these services are not available
off-line and can cost you more.

9) Job Search:

Internetmakeslifeeasyforbothemployersandjobseekersasthereareplentyofjobsiteswhich connect
employers and job seekers.

10) Dating/Personals:

Peopleareconnectingwithothersthoughinternetandfindingtheirlifepartners.Internetnot
onlyhelps tofindthe right personbut alsotocontinue the relationship.



E-mailing

Shortfor electronic mail, e-mail oremail istext messages thatmaycontainfiles, images,
orotherattachmentssentthroughanetworktoaspecifiedindividualorgroupofindividuals.
Thefirste-mailwassentbyRayTomlinsonin1971.By1996,moreelectronicmailwasbeing sent
than postal mail.
“Email,e-mailorelectronicmailisthetransmissionofmessages(emailsoremail messages)
over electronic networks like the internet.”

Email, sometimes written as e-mail, is simply the shortened form of “electronic mail,” a
system for receiving, sending, and storing electronic messages. It has gained nearly
universalpopularityaroundtheworldwiththespreadoftheInternet.Inmanycases,email has
become the preferred method for both personal and business communication.

HowItIsUsed

Messages sent by electronic mail normally reach a recipient’s account within seconds. They
frequentlyincludemorethanjusttext;imagesandnumeroustypesofformatteddocuments
arenoweasilyincludedasattachedfiles.Moreover,itisnolongernecessaryto besittingin front of a
PC to send or receive an email. A variety of mobile devices, such as tablet computers and
smart phones, make it possible manage correspondence on the go.

Most e-mail systems include a rudimentary text editor for composing messages, but many
allow you to edit your messages using any editor you want. You then send the message to
the recipient by specifying the recipient's address. You can also send the same message to
several users at once. This is called broadcasting.

Sentmessages are stored in electronicmailboxes until the recipientfetches them.To see if
you have any mail, you may have to check your electronic mailbox periodically, although
manysystemsalertyouwhenmailisreceived.Afterreadingyourmail,youcanstoreit ina
textfile,forwardittootherusers,ordeleteit.Copiesofmemoscanbeprintedoutonaprinter
ifyouwantapapercopy.E-mailcanbedistributedtolistsofpeopleaswellastoindividuals. A shared
distribution list can be managed by using an e-mail reflector. Some mailing lists allow you
to subscribe by sending a request to the mailing list administrator. A mailing list that is
administered automatically is called a list server.

Togetagraspofwhatemailisitsbest —theterminologyindicatesit—tothinkinequivalents of
"traditional" postal mail.

• The email message -Insteadofusingapentowritealetteronpaper,you'reusingyour
keyboard to type an email message in an email program on your computer.

• Sendingtheemail-Whentheemailisfinishedandhasbeenaddressedtotherecipient's email
address, you don't put a stamp on it and post it but press the Send button in the email
program. This makes the email message go on its journey.



• Email transport -Likepostalservicestransportlettersandparcel,emailserverstransmit
emailmessagesfromsendertorecipient.Usually,emailsarenotdeliveredtotherecipient
directly,though,butwaitingatthe"nearest"mailservertobepickedupbythem.

• Fetchingnewmail-Ifyou'vegotnewmailinyourmailbox,yougoandfetchit.Similarly,
youremailprogramcancheckfornewemailmessagesatyourmailserveranddownload them for
you to read.

BASICCONCEPTSOFACCOUNTING&MANUALACC
OUNTS

Purpose ofkeepingAccounts orNeedForProperAccounts
Systematic recording of business and professional transactions in money terms is a
necessity to estimate, ascertain and forecast the business results. A business enterprise
mustkeep asystematic recordof itsdailytransactions. So that itcan knowwhere it stands and
adjudges its performance. This systematicrecording of transactions is termed as accounting
or book-keeping.
The basic purpose of accounting is to present a complete financial picture of the business
enterprise with the help of two financial statements. The Profit and Loss Account showing
howmuchprofithasbeenearnedorlosssufferedandtheBalanceSheetshowingtheassets and
liabilities of the Business and Proprietor’s interest in the enterprise. The account books are
the financial records which are of interest for the owners and numerous other parties such
as Creditors, Employees, Government, Banks, Financial, Institutions etc. The uses of the
account/ financial statement, to the various groups of person areasfollows:

Ascertainment of true profits.
Ascertainmentofliabilitiestooutsiders.
Ascertainment of growth in capital.
Planningforbusiness.
Costdeterminationandcostcontrolwithpricefixation.

Optimum utilizationofsource, resourcesto keep the fixedassetsintact and in workable
position.

Controloverassets andproperties.
Legalrequirementsasregardstaxationetc.
lityToOthers

Whether the taxes have been duly paid by the enterprise or not.
Whethertheenterprisehascompliedwithallthelegalrequirements.

Whether or not the enterprise to which they have lent money is running successfully and
maintaining its capital intact.

Whethertheenterpriseisearningadequatetopaybackitsloanandinterestintime.
Whether the enterprise are sufficient to secure and repay the loan given by them to the

enterprise.



Toascertaintheprofitsearnedbytheenterprise,sothattheycangetbonusorwages revision fixed
on that basis.

Whetherinviewofpresentfinancialhealthoftheenterprisetheirjobissecuredand permanent.

Whethertheywillbepaidintime.
Whethertheirmoneyissecuredinsuchenterprise.
Whethertocontinuesupplyinggoodsoncreditandallowhighercredit.
ic:

Whetheritisworthwhiletoinvestintheenterpriseorwithdrawtheirinvestment,as debenture
holderorother persons who have given loans to the enterprise.

What IsAccounts?
Accounting:istheartofrecording,classifyingandsummarizinginasignificantmannerand
intermofmoneytransactionsandeventswhichareinpartatleast,ofafinancialcharacter,
andinterpretingtheresultsthereof“Bookkeepingistheartofrecording businessdealing in a set
of books.” Object of Book- Keeping are:
Torecordcorrectlyallbusinesstransactions,whichinvolvetransferofmoneyorgoods?
Toindicatetheeffectofeachtransactionandcombinedeffectofalltransactionsuponthe financial

position of the party entering into the transaction.
LegalRequirementsforMaintainingBooksofAccounts
Cash book, journal and ledger are the basic account books which are supported by vouchers,
purchase and sale bills memos.
Apart from being a business necessity, maintenance of proper books of accounts is
necessary under section 44 - AA of the income -tax Act 1961. It provides for compulsory
maintenance of account by persons carrying on business as well as profession.
Every person carrying on legal, medical, engineering or architectural profession, or the
profession accountancy or technical consultancy or interior decoration or authorized
representative or film artistor company secretary whose gross receipts (not income) from
such profession exceeds Rs. 1,50,000/-. In any of the three years immediately proceeding
the current year is required to maintain proscribed books of accounts.
Penaltyunder Income TaxAct:
Ifapersonfailstokeepandmaintainaccountsbooksorretainthemfortheprescribedperiod
of8years(16yearforcashbookandledgers)heisliabletopenaltyRs.25000/-under section 271A of
the Income Tax Act.
AccountingTerminology

: Businessisagenerictermincludinganyactivityundertaken for the
purposeofmaking profit. Itreferstoanyestablishmentororganizationsetupforthe conduct of
trade, commerce or industry.

Profession is practice of intellectual skill by apersoninaparticularfield
requiring specializedtrainingonthepartofthepersonengagedin it ,forexample a
doctor,alawyer,anaccountant,anarchitect,acharteredaccountantetc.



One who owns the business is called the owner or proprietors. He provides the necessary
capital,attendstobusinessactivities,undertakestheriskofrunningthebusiness,isentitled to
receive the profits and is liable for the losses resulting there from. An owner is different
from the business, in the accountingterminology. He is called a Sole proprietor in oneman
business, partner in a partnership firm.
Accounting Equation: It means that in mathematical terms total assets of a business are
always equal to the aggregate of its liabilities and capital. i.e.

TotalAssets=Liabilities+Capital
Capital: Capital means the amount invested by the proprietor in the business. Suppose
“Sudeep” startsa business with Rs. 1, 00,000/-.Theamount of Rs.1, 00,000/- investedby
Sudeep in the business is called the capital of the business. For the business, capital is a
liability towards the owner.
Drawing:Drawingrefertotheamountofcashorvalueofgoodswithdrawnbytheproprietor out of
business for his personal use. Suppose “Ramesh” withdraws Rs.20, 000/- from his business
for purchase of “scooter” for his domestic use. The amount of Rs. 20,000/- withdrawn by
the proprietor for his personal use is called drawings.

Goods:Thethingsoritemsinwhichabusinessdealsarecalledas“Goods”forthebusiness
exampleinastationaryshopgoodsmeans“StationaryItems“.InaFurnitureShop/Business goods
means “Furniture Items”.

Debtors:The term “debtor” represents the persons who have purchased goods on credit
fromthebusinessandhavenotpaidforthegoodssoldtothem.Forexampleifgoodsworth Rs.
10,000/- have been sold to “Mahesh”, he will continue to remain the debtor of the business,
so far,he does not make the fullpayment. Thus “debtor”is a person from whom the
business has to receive some money on account of goods supplied /sold (on credit).

Creditor:Creditor is a person to whom a business owes money for the goods purchased
from suchperson on credit. Supposeafirm purchased somegoodson creditfrom Mahajan
Traders for Rs. 30,000/- . In such a case Mahajan Traders will continue to remain the
creditorsofthefirmsofarthefullpaymentofRs30,000/-isnotmadetoit.

Income/Revenue:Itisthemonetarygainresultingfromthesaleofgoodsorservicesduring a given
period and is measured by the price charged from customer, clients or tenants for goods
and service furnished to them. It also includes interest and dividends earned on
investments and rent received from letting out property.

Expenses:Expense refers to an expenditure whose benefit is enjoyed and finished
immediately.Examples of expenses are: Rent of Building, Salary Paid to Employees,
WagespaidtoLabour,paymentofTaxichargesetc.Expenseisthecostof use of thingsor services
For the purpose of generating revenue. Expenses are voluntarily in curved to generate
income.

Losses:Losses are unwanted burden which the business is forced to bear. Loss of goods
duetotheftorfire,orfloodoraccidentistermedas“loss”inaccounting.Lossesaredifferent
fromexpensesinthesensethatexpensesarevoluntarilyincurredtogenerateincome,where as
losses are forced to be borne. Losses are outcome of the activity. They are beyond control.



Assets:Assets mean right of ownership over anything valuable. This refers to properties
that can be expressed in terms of money like plant and machinery, vehicles, stocks, cash
etc. It alsoincludesmoneydue to the businessfrom debtors.Forgoodsand servicesorfor
moneylent.Rightsavailabletoabusinesssuchaspatentorcopyrightsgoodwill,trademark etc. is
also included in assets.

Net Worth:Networthof abusinessistheexcessofitstotalassetsoveritstotalliabilitiesto outsiders. Net
worth is the amount payable or recoverable from the owners of the business. Profit
(Income):Excess of allrevenues over allcostsandexpenses is called profits (income).

Purchases:Purchases means purchase of goods. Goods purchased on cash are called
“cashpurchases” and those purchased without payment at the time of purchase are called
“credit purchases”.

Purchase Returns: Goods returned to the seller, being in excess of the quantity ordered or
found to be defective, or for any other dispute, are called purchase return.

Sales:Sales refer to sales of goods to customers. Sales for cash are called “cash sales” and
when payment is not received at the same time it is called Credit Sale.

Sales Returns: Goods returned by the costumer due to some defects, or excess quantity etc.
are called as sales returns.

Voucher:A voucher is a written documentary proof originating and supporting a business
transaction. It is the basis of recording a transaction in the books of account. For example
cash-memos, pay-in-slips, invoices etc.



MEANINGOFBOOK KEEPING
‘Book-Keeping’ isacompositetermmadeof‘book’and‘keeping’Theword‘book’refersto booksof
accountand ‘keeping’refertomaintenanceina systematicmanner.Book keeping is the
systematic record of business transactions in a set of books.
Business involves a number of transactions such as buying, selling, receiving, paying etc.
which cannot be remembered for a long period. As such, it becomes necessary to write or
recordthetransactionsinbookofaccountinascientificmanner.Book-keepingis,therefore the art
of applying the principles of accounting, in keeping books of account.
According to Mr. J.R. BATLIBOI, “Book-Keeping is the art of recording business transactions
in a set of books.”
RecordingofBusiness TransactionsIsToBe DoneInaProperSetOf Books
Bypropersetof books,wemeanthevariousbooksofaccountorregistersmaintainedbya
businessman from which he wants to ascertain the necessary information regarding the
affairs of his business.
Thetwomostimpotentbooksofaccountsmaintainedbyabusinessare:

Insteadofabove,thefollowingsubsidiarybooksallorsome,accordingtorequirementsmay be
prepared:

/Purchase DayBook

BookKeepinginvolvesthefollowingsteps:
All business transactions which are financialin nature desirablyhaving documentaryproof are
accounting transactions.

ngofLedger Accounts

Accounting:Accountingmaybedefinedastheartofrecording,classifyingandsummarizing the
dayto daytransactions of the businessand interpreting the results there off.
DifferencebetweenBookKeepingand Accounting:

k



BookKeepingisanarrowterm,concernedwiththeartofrecordingthedaytodaytransactions of the
business in proper books of account.

The term Accounting is wider in meaning and is concerned with recording, classifying and
summarizing the daily business transactions and interpreting the results there of. Book
Keeping is infecting the part of Accounting.

AdvantagesofBook-Keeping&Accountancy

Avoidance of the Limitation of Memorizing Power:Duetolimitedmemorizingpower,
abusinessmanmaynotrememberallhisbusinesstransactionsforalongperiod.Accounting helps
him in keeping a permanent record of his business transactions.

Ascertainmentof Profit and Loss of theBusiness : It helps the businessman in
ascertainingtheprofitorlossmadebyhisbusiness,overaperiodoftime(By preparingProfit & Loss
Account).

To know the Financial Position of Business:By preparing Balance Sheet, the
business man comes to know about the asset, liabilities, capital etc. of the business at a
point of time.
AssessmentofTax:Nowadaysabusinessmanisrequiredtopayanumberoftaxes that is

Income Tax, Sales Tax, Excise-duty etc. Fair assessment of these taxes is possible onlyif
proper and systematic records of income, sales and production of the business have been
maintained.

Knowledge of Debtors/ Creditors:A businessman can daily know theamountdue
fromhisdebtorsandamountduetohiscreditorsifhehasmaintainedproperrecordsofhis
transactions with debtors and creditors.

ObjectiveofAccountingAccountings:

BookKeeping:TomaintainAccountbooks



BillReceivableBook

ObjectiveofFinancialAccounting
FinancialAccounting is the artof recording,closing and summarizing in a sufficientmanner
and in forms of money transaction and events which are in part at least of a financial
character and interpreting the result there off.
TheobjectiveoffinancialA/Cis

To keep systematic record of business
Toprotectbusinessproperties:ThisisonlypossibleonA/Cof supplying
the following information to the manager etc.
Theamountofproprietor’sfundsinvested. How
much the business has to pay?
Howmuchthebusinessisrecoveredfromothers?
Howmuchthebusinesshasintheform offixedassets? “Cash” in
hand
“Cash” at
bankStockofrawmate
rial Work in progress
Finished goods.

t it
owes andwhat itswons.

Golden RulesofAccounting

Therearebasicallythreetypesof accounts:

Basic Principle:



Thetransactionsofabusinesswhichrelatetoindividuals,businessenterprisesorother
organizations are classified as transactionsrelatingtopersonalaccountunderpersonal
account a person either receives something from the business or givessomething tothe
business like any person RAM, VIJAY, SUNITA, LAL&CO, BANK, HOSPITAL,
SHOPS,CLUB,HOTAL,CINEMAHALL, whose capacity is of receiver/ giver.

Personal AccountIsAOperator

DEBITTHERECEIVER
CREDIT THE GIVER

Example:CashpaidtoSH.K.L.SHARMARs10000/- Sh.K.L.Sharma --->

Receiver ---> Dr. cashreceivedfromMannRs5000/-Cr.

Mann---> Giver---> 5000/-Cr.

:
Remainingtransactions ofabusiness havebeengroupedunder

“Real Account” These include all transactions whichrepresentreceiptsbythebusiness,
whether of properties,goods or services and all out goings from businesslikeallsale,
purchase , cash, assets, land and building, machinery vehicle, means assets and liabilities
which has money value other than Personal Account.

RealAccountIsASourceOfOperation

DEBIT WHAT COMES IN
CREDITWHATGOESOUT
Example:CASH ---> COMESIN---> DR

CASH ---> GOESOUT---> CR.

:
Thetransactionsofabusinessrelatingtoincurringofan

expenditure or loss and earning of income or gain are classified by Nominal Accountlike :
discount, rent, loss due to fire, insurance, traveling, salary, wages, rent, commission,
freight, octroi, bank charges, donation etc.

NominalAccount IsAResultOfOperation
Account

DEBITALLEXPENSE&LOSS
CREDITALLINCOME&GAINS.

Example: RentPaidRs3000/-
Rent ---> Exp. ---> Dr.
Interest recieved Rs. 300/-
Interest ---> Income ---

>



Cr.

Transaction
DOUBLEENTRY SYSTEM

Every business event or transactions has two aspects. If it increases any asset it either
increases liabilities correspondingly or reduces some other asset. Likewise, incurring of
expenditure involvesdecrease in an asset or increase in some liability.
So recording the double effect of any transaction is known as double entry system. As the
assets of a business are always matched by an equal amount of financial claims against
them,alltheaccountingtransactionsmaintainthisequalityandnoentryfor recordingofan
accountingtransactioniscompleteunlessthedebitisequalinvaluetothecreditentry.This is the
rule of Double Entry.
Double Entry system facilitates automatic checking of arithmetical accuracy of books of
accountsthroughpreparationofTrialBalance.OncetwosidesofTrialBalancehaveagreed, it
normally leads to a confidence that books of accounts are arithmetically correct.
Under this system position of any particular aspect of a business can be easily ascertained
inthemannerthatDebtor’saccountorsupplier’saccountgivescompleteinformationabout balance
outstanding in their account at any point of time.
Voucher
Voucher is documentary evidence in support of a transaction. These documents may be
internalorexternal.Underthedoubleentrysystem,recordingofatransactionoriginatesfrom a
Voucher. Followed by an entry in the prime books of record that is journal or cash book.
TypeofVoucherisspecifiedbyNarration.NarrationistheprooforevidenceofanyEntry or
Transaction. Narration is of different types:
Like

--->
--->

CapitalIntroduce
Cash depositedintoBank

---> Bill.M No.
---> C.MNo.
---> C.MNo., R.No.

Cheque---> Chq.No.
---> D.D. No.
---> ToMohanForthemonthofApril99
---> Topaid for themonth of March 99

Somedifferenttypesofvouchers areusedinbusiness:

This Voucher is used to record all payment and other expenses paid in cash. In case of
expenses the relevant support of expenses such as cash memo or bill etc. should be
attached so far as possible. In case of cash payment exceeding rupees fifty it is necessary



to affix revenue stamp on the voucher to make it legally enforceable. The signature of
recipient should be obtained on voucher across the revenue stamp.

:ThisVoucherispreparedforrecordingallreceiptsofmoneywhetherby cash
or by cheque and on whatever Accounts.

:Ajournalvoucherispreparedtorecordtransactionsotherthanthose
involvingcash.Journalvoucherispreparedtoensurethateachapprovedliabilityisrecorded as
incurred.

Journal is a systematic recording of transactions on the basis of VOUCHERS as
anwhentheyoccur.Itisabookofprimaryentryorfoundationforaccounting.
Procedurefor recording transactioninthe Journal:
Ineachtransactionidentifytheheadofaccounts. Classify
the identified Accounts.
ApplytheappropriaterulesofDebit/Credit.
Record the debit account firstly in the particulars columns with the date and amount in the
debit column.
Then enter the credit account by starting with “To giving a little margin in the left hand side
and put the amount in credit column.
Givethebriefnarrationofthetransactionintheparticularcolumninrespectoftheentry.

Example:
CashReceivedfromSharma1000/-

Cash-->comesin-->Real-->DR1000/- Sharma--
>giver-->Personal-->Cr1000/- Cash A/c Dr.
1000/-

ToSharma’sA/c1000/-
(OnreceiptofcashfromSharma’s)

Rent paid to Mr. Mohan for Jan 2001 Rs. 5000/- Rent --> Nominal --> Exp. &
Loss --> Dr. 5000/-

Cash --> Goes Out --> Real --> Cr. 5000/-
Rent A/c Dr. 5000/-

TocashA/c5000/-
(BeingpaidrentforthemonthofJan2001ToMr.Mohan)

SomeImportantHeadsofExpenditure Rent
A/C
Water &Electricity A/C
Telephone&TrunkCallA/C
Office Expenses A/C
MiscellaneousExpenseA/C

Salary A/C (Administrationstaff)
Wager A/C (Factory Labour)



ProfessionalchargesA/C
AuditExpense A/C(C.A./Auditor)

LegalExpenseA/C(Advocate+Stamps) Printing
& Stationary A/C

Postage & Telegram A/C
Traveling&ConveyanceA/C
Petrol & Maintenance A/C

DonationA/C(ReceiptrequiredaboveRs50/-) Purchase
A/C

Staff Welfare A/C
Entertainment A/C

BusinessPromotionorAdvertisementA/C
Repair & Maintenance A/C
Freight & Cartage A/C

Newspaper&PeriodicalsA/C
Furniture&FixtureA/C

Drawing A/C
InsuranceA/C

ParkingChargesA/C
Interest A/C

Sales promotions A/C
DiscountandallowancesA/C

BaddebtsA/C
MahuratExpense,A/C
Bank Changes A/C

DepreciationA/C



CashBook
MAINTAININGACCOUNTSBOOKS

A cash book is a record of all cash receipts and payments kept and maintained from day to
day and giving the cash balance in hand at the end of a specified period not exceeding a
month. A cash book records all cash transactions with their further classification and
summarization. There are two types of transactions recorded in cash book.

It’shavingonlyone effectand comesinoutercolumnof cash book.Cash Dr.orCash Cr. In
cash Book, Cash A/C not to be mentioned.

NonCashishavingDoubleeffectCr.andDr.andcomesinInnercolumn.The cash
book is normally divided into two parts:

Thelefthandsideisusedforrecordingallreceiptsofcashorwhetheritisloanorincome
ortheproprietor’scapitalintroducedintothe business andtheright hand side records all

payment, whetherpaymentforexpensesorrepayments of loansandforCash Balanceat the
end of the daytotal of receipts minustotal of payments.

Ledgers
Ledgers are the main book of account which classifies and summarizes transactions and
events into groups according to their nature. For example all the transactions relating to
purchasearerecordedinaseparateaccountnamely‘Purchase Account’ thoserelatingto sales
in a ‘Sales Account’, expense of different nature are recorded in different accounts so
that expenses of a particular type are reflected at the same place.
Ledger Posting:
Accounts for each item are indexed and maintained in ledger and the entries in the ledger
arepostedfrom cashbookanditis verysimple. Allcash andnoncash creditentryincredit side and
debitentryin debit side anda balance account mayhave a debitbalance, a credit balance or
nil balance.
TrialBalance
Afterpreparingthecashbookandledgerthenextstageistoprepare“TrialBalance”.
WhatisaTrial Balance?
Trial Balance is a statement prepared with the debit and credit balances of ledger accounts
to test the arithmetical accuracy of the books of Accounts. Special Features of Trial
Balance
The TrialBalanceispreparedonaspecificdate.
ItispreparedwiththedebitorcreditbalancesofLedgerAccounts. It
contains the list of all ledger accounts including each balance.
TheamountcolumnofTrialBalanceisdividedas“DebitColumn”and“CreditColumn”.

:



Thetotalofthedebitandcreditcolumnoftheamountmustbeequal.
If the total of debit and credit side doesn’t tally, it means that certain mistakes have
beencommitted somewhere in Cash Book, Ledger, and Journal.
CashinHandistakenfromthecash book.
ClosingstockiskeptoutofTrialBalance.
OpeningstockfromBalanceSheetofPreviousyear.

Whyis Trial BalancePrepared?
TheTrialBalanceispreparedforthefollowingobjects.
Tocheckthearithmeticaccuracyofthebooksofaccounts. To
obtain the summarized position of ledger Accounts.
Basis for preparing Final Accounts like “Trading and Profit and loss Account” and
“BalanceSheet”.

FinancialAccounts
Assets&Liability
Assets: Assets are the resources raised by the business from the funds made available either
by the owner or others.

Kinds ofAssets
Fixed Assets: There are acquired for relatively long periods for carrying on business and
are not meant for resale like Land, Building, Machinery, Furniture & Fixture, Copyright,
Goodwill, Trademark, Computer, Typewriter, Air Conditioner and Television etc.
InvestmentandAdvances:Otherthanintheregularbusinessarecalledinvestment.

Current Assets: These are those assets held in the business which are expected to be
converted into cash within 12 monthsi.e. isinshortrune.g. Cash in hand

Cash at bank
MarketableSecurities
Debtors
Advances to Staff
AdvancestoSupplier
Earnest Money
Prepaid Expenses
Closing Stock

Liabilities
Capital:Share CapitalorEquityCapital.

SecuredLoan:Theloantakenagainstsecurityiscalledsecuredloan.Itiscalledlongtermloan (>12
months) from bank.



UnsecuredLoan:Thisisshorttime(<=12months)loanwithoutsecurityfromfriends,relatives etc.

CurrentLiabilities:Creditorsbillspayable,advancesreceivedfromsupplier,securities received, out
standing expenses. Which is expected to be paid within 12 months?

AdjustmentInProfit&LossA/cwithJournalEntries:
Salary and Salary payable (SalaryDues willbe shown asSalarypayable).
Salary A/C Dr.
ToSalarypayableA/CCr.
In Profit&LossA/C itwill be added inthe salaryA/C and inBalance sheetit will be shown as salary
payable.

Telephoneanytelephone bill outstanding
Anytelephonebillreceivedbefore31stmarchnotyetpaidwillbeshownasdue.
Telephone A/C Dr.
ToTelephoneExpensesPayableA/C
InProfit&LossA/CitwillbeaddedinTelephone&TrunkcallexpensesA/CinBalancesheetit will be shown
as liability.

Water &ElectricityPayable
Anywaterelectricitybillreceivedbefore31stMarchnotyetpaidwillbeshownasdue.
Water&electricityA/CDr
Towater&electricitypayableA/C

AdvanceGiven
InsurancespaidinAdvancewillbedeductedfromexpenditureandinBalancesheetitisshown as an
asset.

Prepaid insurance A/C Dr.
To insurance A/C Cr.

Income due (butnotreceivedisalsoknownasaccruedincome -Receivable)Accrued Tuition
fees A/C Dr.
ToTuitionFeesA/CCr.

Tuition fees will be added in the income shown in Profit & Loss A/C and accrued Tuition Fees
will be shown as an asset.

Loss ofstockbyfire:There are two typesof lossof stock
UninsuredlossInsuredloss

Closing: Accounts are closed on 31/3 and financial accounts are prepared to know the
standingof thebusiness duringthe previous yearwith regard toProfitand LossandAssets and
Liability.

: Costofproduction
: GrossProfit

: NetProfit

: BalanceofAssetsandLiabilities



Closingstockiskeptout ofTrial Balance.
Closingstock:RawMaterial,WorkInProgress, FinishedGoods
Openingstock:RawMaterial,WorkInProgress,FinishedGoods
Profit & Loss A/c: A Profit and loss Account shows the total revenues/ incomes from the
saleofgoodsorservices,duringanaccountingperiodandthetotalexpensesincurredduring that
period in earning the revenues, Excess of revenues over expenses is the net profit or net
income. If total expenses are in excess of revenues, the net result is loss.
Balance Sheet:A Balance sheet is a statement showing the state of affairs of a business as
on a specified date. The state of affairs includes what the business owns and what the

businessowes.Itdisplaystheproperties,assetsandotherrightsownedbythebusinesson the right
hand side. The liabilities to outsiders and amounts invested by owners as capital on the left

hand side. Balance sheet reflects as to what proportion of the total assets belongs
toproprietorsof businessandwhat proportiontooutsiders. It is aformal representation of the

accounting equation

BASICCONCEPTSOFTAXATION
Types ofTax: Taxesarebasicallyoftwotypesi.e.DirectTaxandIndirectTax
1. Direct Tax: wheretheincidenceandimpactofTaxisontheoneandsameperson,then

itiscalledaDirectTax.InotherwordswecansaythatwheretheTaxischargeddirectly on the
Person, it is a Direct Tax e.g. Income Tax.

2. Indirect Tax: where the incidence of Tax is on one person and its impact falls on the
other person, then such Tax is called an Indirect Tax. In other words we can say that
where the tax is charged on the Person indirectly, it is an Indirect Tax e.g. Sale Tax,
Service Tax, VAT Tax etc.

IncomeTax:Tax planning is crucial as it reflects on your financial situation and also involves
planning for post-retirement life. The Income Tax Act has provisions for benefits,
exemptionsanddeductionstohelpyoureduceyourtaxesandsavemoney.Incometaxisan annual
taxon income. The Income TaxAct (Section 4) provides that in respectof the total income of
previous year of every person, income tax shall be charged for the corresponding
assessment year at the rates laid down by the Finance Act for that assessment year.
Previous Year: Incometaxiscalculatedontheincomereceivedoraccruedduringafinancial year, and
that year is known as the previous year.
AssessmentYear:Assessmentyearistheyearafterthepreviousyear.
Assessed : An assesses is a person who pays taxor anyother amountunder the IncomeTax Act.
Person : Section 2(31)of the Income TaxAct defines a person asAn individual, A Hindu
undivided family, A company, A firm, An association of persons or a body of individuals
whetherincorporatedornot,Alocalauthority,Everyartificialpersonnotfallingwithinany of the
proceeding categories.
Assessing Officer: An assessing officer is the Income Tax officer, or the assistant
commissioner of Income Tax officer, or the deputy commissioner of Income Tax, or the
joint commissioner of Income Tax, who has jurisdiction over an assessee.The assessing
officer makes the assessment and collects taxes under the Act.
CALCULATEYOURTAX



Step 1: Asses your income. Each of these heads recognizes an income from a different
area orprofessionandis classified under differentheads.Eachof the headsof incomeallows
certain deductions or exemptions as per rules.
Step2:Aggregatethegrossincome. The nextstepistosumuptheincomeunderthe different

heads to arrive at the gross total income.
Step 3: Calculatethenettaxableincome.Fromthegrosstotalincome,theIncomeTax Act

allows certain deductions under chapter VI A to arrive at the net taxable income.
Step 4: Calculatetax.Onthisnettaxableincome,calculatethetaxpayableasperthe tax-

slabs given in the finance act every year.
Step5:Deductrebates.Taxrebatesareavailableundersection88,88Band88Con certain

conditions. Deduct these rebates from tax payable.
Step 6: Final tax payable. If you have paid any advance tax or have tax deducted at

source,reducethesamefromthebalancetaxamount.Anyadditionaltaxshouldbepaid as self-
assessment tax before filing the income tax return.
Gross Total Income (GTI): Section 14 of the IncomeTaxAct providesthatforthe

purposeofchargeofincometaxandcomputationoftotalincomeallincomeshallbeclassified under the
following heads of income:
1. Incomefrom“Salaries”.
2. Incomefrom“HouseProperty”.
3. Incomefrom“BusinessorProfession”.
4. Incomefrom“CapitalGains”.
5. Incomefrom“OtherSources”(anyincomethatdoesnotcomeunderanyofthe above

heads)
Thetotalincomefromalltheaboveheadsofincomeiscalculatedinaccordancewith

theprovisions of the Act as theystand on thefirstdayof April of anyassessment year.

Salary: Section17(1)oftheIncomeTaxActgivesthedefinitionofsalary.Essentially,income from
salaryconsistsofalltypesof cashamountpaid toanemployeeforservicesrenderedto an employer.
You should have an employee-employer relationship and such cash amount is taxable as
‘salary’. It includes basic pay, dearness allowance, overtime, bonus, incentives, allowance,
and Children allowances. Some of these allowances are exempt from taxes under section 10
subjects to limits, after which standard deductions are allowed under section 16 and then the
final net income is computed.
Salaryfrom more than one source: Salariesreceivedfrommorethanoneemployerduring a
year are taxable under salary. Such salaries are aggregated or clubbed together. House
Property: This is the second head for taxable income. The IT Act classifies house property
under two distinct heads: self-occupied property and let out property. The house owner has
to ascertain an annual value on these properties, which is taxable income. Self-occupied
property: Simplyput,theannualvalueofthehousewheretheownerisresiding,andwhich has no
been let out, is taken as ‘nil’.
Letoutproperty:Forthepropertythathasbeenletoutordeemedtobeletout,thetaxable value of the
property shall be the higher.

PROFIT FROM BUSINESS OR PROFESSION: Thisisthethirdheadunderwhichtaxableincome has to
determine and in the case of individuals, it is applicable to those who are selfemployed, the
sole proprietor of the business, or a professional. Business can be explained asanytrade,
commerce, ormanufacture, or anyconcern in the nature of trade, commerce or manufacture.
Profession includes any profession that requires manual or



intellectual skills. Professions include categories such as doctors, lawyers, singers etc. Any
profitsorgainsfrombusinessorprofessionoranyotherserviceshallbetreatedasincome from
business or profession. Important expenses can be claimed as deductible expenses, some of
which are:
Rent,Taxes,RepairsAndMaintenanceOfBuildings,Salary,Bonus,AndCommission To

Employees Expenditure Incurred On Entertainment, Traveling, Advertising Etc.

Capital Gains: This isfor those who have made a profitor a loss byselling a capitalasset
andbymakingcapitalgains thereon. Capitalasset ispropertyof anykind held byaperson
whether or not it is connected with his business. However, it does not include inventory,
raw material or stores for the purpose of business, or any personal goods such as clothes
and moveable property, and jewellery. Rural agricultural land and gold bonds and gold
deposit bonds, too are not considered capital assets. Short and long term assets asset’s
naturealongwithitsholdingperiod(thenumberofyearsofpossession)determinewhether an
asset is a long or short-term one.

INCOME FROM OTHER SOURCES : ThisistheIncomethatcannotbeclassifiedunderanyofthe
above heads such as salary, house property, etc. Interest income from securities, company
fixed deposits, savings accounts, bank deposits, pension received by legal heirs andlotteries
come under this head.

Service Tax: Servicetaxistaxof21stCentury.ServiceTaxisaformofindirecttaximposed
onspecifiedservicescalled“taxableservices”.Servicetax cannotbechargedonany service which
is not included in the list of taxable services. Over the past few years, service tax been
expanded to cover new services. The intention of the government is to gradually increase
the list of taxable services until most services fall within the scope of service tax.

Value Added Tax (VAT): VAT or ValueAddedTaxis a consumption tax, which is charged at
each stage of production based on the value added to the product at thatstage. Many
StatesinIndiahaveadoptedVATinplaceofsalestax.Inthesalestaxstructure,thereare problems of
doubletaxation of commodities and multiplicityof taxes,resulting in a cascading tax
burden.VAT is a modern and simplified system of taxation where the tax is
leviedandcollectedateachstageonthevalueadditionswithaprovisionforsetoffagainst taxpaid at
the variousstages / taxpaid on inputs. VAT is a system of indirecttaxation, which has been
introduced in lieuof sales tax. It is the taxpaidbythe producers, manufacturers, retailers or
any other dealer who add value to the goods and that is ultimately passed on to the
consumer. VAT has been introduced in India to ensure a fair
anduniformsystemoftaxation.Itisanefficient,transparent,revenue-neutral,globally acceptable
and easy to administer taxation system. It benefits the common man (consumer),
businessman and the Government.

Banking System: TheBankingSectoristhemostdominantsectorofthefinancialsystem in India,
and with good valuations and increasing profits, the sector has been among the top
performers in the markets. Banking dates back to 1786, the first bank established in
India,thenthenationalizationofbanksin1969.InIndiathebankingsectorisSeparateas public or
private sector banks, cooperative banks and regional rural banks. Foreign banks have
been given a different head followed by upcoming foreign banks in this section.
Bunchof servicesareatcustomersdemandintoday’sbankingsystem.Differenttypesof accounts
and loans, facilitating with plastic money and money transfer across the globe.



TypesofBusiness
Therearefourtypesofbusiness:
Proprietorship:(Singlepersonorsole proprietor)
No formalities arerequired,
Noregistrationorwhatever.
Firm: (Partnership)
Member 2-20 Registration - Not compulsory, but it is advisable to get it registered with the
registraroffirms.ItisregisteredinEstateOfficeinRegistrar’sOffice.Registrationisapplied on Form
no 1. Registration fee is Rs 3.00 deposited through Challan no. 32A .Chillan Code no-
HeadofA/c1475-OtherGeneralandEconomicAccount.UnderPartnershipAct,1932 partnership
Deed on stamp paper of Rs 25.00 and attached toapplication Form no. 5 is used for
incoming and outgoing members.

PrivateLimited Company:
It’shavingmember2to50atleasttwodirectors.
Registrationiscompulsory.RegistrationisdoneinRegistrarofCompanies,JalandharforHimachal,
Punjab and Chandigarh.
WecannotstartwithoutRegistration. It
can not issue shares.
Registrationfee isbased on CapitalIthas
contributory capital of all members.

Public LimitedCompany:
Members7tonolimit.
Registration is compulsoryin the Office of Registrar of Companiesnear busstand, Jalandhar. It
can issue shares.
Ithassharecapitalofallshareholders.

Depreciation: Depreciation A/Cischangein the valueoffixedAssets throughwearand tear
and obsolescence due to passage of time or Reduction in the value of fixed assets, except
Land. These are called Adjustment entries.
Rateofdepreciationissameforeverytypeofbusiness.

Land : Nodepreciation
Building : Residential : 5%value isdecreasedeveryyear

CommercialArea: 10%
Furniture : 10%is ordinaryBusiness:15%isRushArea(School, Club,

Academy)
Vehicle : 20%inordinarybusiness,40%ifusedforTransportBusiness
Machinery : Lessthan5000/-or100%Depreciationwillbecharged.
Fridge/AC/T.V/Typewriter/RemainingElectronicsitemetc -25%,computer60%

IncomeTax andAccounts
Accountsbooksshouldnotonlyshowatrueandfairviewofthebusinessprofitsanditsstate
ofaffairsbutshouldalsoenablethetaxingauthoritiestocalculatethetaxableincomeofthe



businessTheaccountbooksshouldthereforebemaintainedinamannerthatisacceptable
totheincometaxauthorities.Booksofaccountsmustbepreparedinsuchamannerthatthe account
is not rejected by income-tax authorities on ground that:
Incomecannotbeproperlydeterminedtherefrom. The

accounts are not correct & complete.

The method of accounting has not been consistently followed by the assesses.

Therearesufficientandstrongreasonstoindicatethattheaccountsareunreliable.

Wheretherearedefectsandomissionsandtax-payerfailstoexplainthemunsatisfactorily.
Where there is no quantitative tally between purchases and sales and there are
suspiciousfeatures.

Ifonlyapartofsalesorpurchasescanbeverifiedandrestcannotbeverifiedorsome purchases are
omitted from records.

Theabsenceofproper documentary evidencetosupporttheentriesintheaccount would remake
the account liable for rejection.

itappearsthatthecashbookhasbeenwrittenupatastretchandnotformdaytoday.

Wheretheaccountshowanabnormallylowrateofprofit.

IncomeofFiveTypes
Income from salary
Incomefromhomeproperty
Income from business
Income from capital gain
Incomefromothersourceslikelottery

If



COMPUTERIZEDACCOUNTING
IntroductiontoTally
AmongthemostimportantapplicationofcomputersintheofficesistheFinancialAccounting. It has
made the life of accountants very easy. Gone are those days of spending long hours
totallytheaccountsmanually.Thesedaysmostofthecompaniesusecomputerizedfinancial
accountingfortheiraccountspurposes.Evenmostof theCharteredAccountantsusethem. Now
the software used by them may differ from user to user.
In these recent yearson the Indianmarket,onefinancialaccountingsoftware which has taken the
fancy of most of the accountants is called Tally.
TallyScreen
ThefollowingcanbeseeingontheTallyscreen initially.
AsyoucanseefromGatewaytoTally,thereare3optionshere:
SelectCompany
CreateCompany
Quit
I am sure you do not want to quit at this stage. Since you have not created a company, so
you would not be able to select any company. Hence the only logical selection here would
be Create a Company. So let us do it.
CREATEACOMPANY
To create the company, you would click at Create a Company, or F3 key, various items on the
screen are described below:
Name:Typeherethenameofthecompanyyouwanttocreate.
MailingName:Typeherethemailingnameofthecompany.
Address:Typeheretheaddressofyourcompany.
IncomeTaxNumber:Inthecaseyourcompanyhasbeenallottedanincometaxnumber,just fill it up
here.
Local Sales Tax Number: IfyourcompanyhasbeenallottedanynumberundertheSalesTax Act,
then fill it up here.
Inter-StateSalesTaxNumber:Againfillthisnumberifithasbeenallottedtoyourcompany.



CurrencySymbol:Youhavetospecifythecurrencysymbolwhichyouaregoingtouse.
Maintain:TherearethreedifferentwaysyoucanuseTally.
Theoptionsare:

Accountsonly
Accounts-with-Inventory
Inventory only

Accounts only Usethisoptionifyoudonothaveanyinventorytransactions.Usingthisoption you
would not be allowed to have any inventory transactions.
Accounts-with-inventory Though this is selected by default, you can always differ to use
your own option. Using this you would be able to use both Financial as well as Inventory
Management.
Inventory only Use this if you have to useTallyfor inventoryonly. You would not be ableto do
any accounting related processing if this option is used.
BooksBeginningFrom:Typeherethedatefromwhichyouactuallywanttallytomaintainyour
accounts.
UseSecurityControl:This optionallowsyoutoprovidesecuritypassword toyourcompany.
BasicCurrencyInformation
The best part of Tally is that you can work in any currency accounting system. You can in
factuseanyforeigncurrencytoo.Inthissectionyouhavetoprovide informationrelatedto this.
Basic Currency Symbol: Specify the symbol of your base currency.” For example for an
Indian company the base currency is Rupees, whose symbol is “Rs.”, therefore specify this
symbol here. Tally uses this symbol in reports, whenever necessary.
Formal Name: Now that you have decided on the currency symbol, you can decide about
the currency”, name too. Remember, Rupees is also available in other countries too, for
example, Nepalese Rupees. If you wish you can write, here Indian Rupees.
NumberofDecimalPlaces:Inthisoptionyoucanspecifyavaluefromzerotofourtodenote the
fractional part of the currency. For example, the fractional part of the Indian Rupee is Paisa
for which the number of decimal places is two. The default option is also two.
Show AmountinMillions?:BydefaultthisoptionisNo,whichmeansthattheamountwill be
displayed inlakhsand crores. In case you wantthe amountto bedisplayed inAmerican system
of millions, then select Yes.
Is Symbol SUFFIXED to Amount? : Most currencies have the symbol prefixed to the
amount, for example, Rs. 165.00 or $375.00, but some currencies take the symbol to the
rightofthedigits,forexample600Yenor1000Lira.Dependinguponthecurrencyyouwish
todealin,chooseanappropriateoption.ThedefaultchoicefortheoptioninNo.Thismeans that the
symbol be on the left hand side of the digits.
PutaSPACEbetweenAmountandSymbol?:Inordertoinsertaspacebetweenthecurrency symbol
and the amount choose Yes and to remove the space specify No.
With this you end the options for creating a new company. Press <Enter> to get a small
windowwhich promptsto answer in Yesor No whether toacceptthefiguresasit isornot. Press
Y to accept and create the company.
A created company would look like the one shown on the page. Now we have to enter
otherinformation about the company.
Variousitemswhichcanbeseenonthescreenaredefinedasfollowing:Current period:
It displays the financial period in which you are working.



Currentdate:Itdisplaysthedateonwhichyouareenteringvouchersorviewingreports.

List of Selected Companies: It displays the list of companies you selected. The company
onthetopofthelistinboldisthecurrentlyactivecompany.Inordertochangethecurrently active
company, click on another company in the list or press <F3>.
DateofLastEntry:Itdisplaysthedateoflastvoucherenteredinthecurrentlyactivecompany.
Gatewayof Tally: Thismenudisplaystheprimaryoptionsavailabletotheuser.Thesemenus are
briefly mentioned here.
Accounts Info: This option permits you to handle all the information related to financial
accounts. It allows you to work on creation and maintenance of masters like Ledgers, Cost
Centers, Cost Categories and other related information.
Inventory Info:Using this option you can handle information relating to the inventory
accounts. It enables you to work on stock items, stock groups, stock categories, units of
measurement and other inventory related information.
Voucher Entry: Thisisthemostfrequentlyused option. Itallowsyou tomake dailyvouchers.
BalanceSheet:Thisoptiondisplaysthebalancesheetofyourcompanyasperthelastvoucher entered.
ProfitandLossA/C:Thisoptionallowsyoutotakealookatgrossprofitandnetprofitforboth opening
and closing stock.
Ratio Analysis: Thisoptionenablesyoutohaveabird’seyeviewofyourcompany.Justby
lookingattheratioofassetsandliabilitiesloansandprofit,youcanjudgethefinancialstatus of your
company in a flash.
Display: This option enables you to view all reportslike, Trial Balance, Account Books,
Statement of Accounts, Inventory Books, Statement of Inventory, Cash Flow, List of
Accounts, etc.
Multi-Account Printing: ChoosethisoptiontoprintAccountBooks,InventoryBooksandDay Book.
TheButtons:Theyareontherighthandsideofthescreen.
F1:SelectCompany: ThisenablesyoutoselectcompaniesandaddthemtotheListof Selected
Companies.
F1:ShutCompany:Thisenablesyoutoshutdownaselectedcompanyandremoveitfromthe list of
active companies.
F2:Date:Inordertochangethedate.
F2: Period: Usingthisoptionyoucanchangethefinancialaccountingperiodofacompany. F3:
Change Company: This option is accessible onlyif more thanone companyis present in the
list of selected companies. Choose this option when you want to work on another company
that is in the list.
F3: Create Company: Thisoptionenablesyoutocreateanothercompanybybringingupthe
Company Info menu.
F4: Backup: Thisoptiongivesyouaprovisionofbackingupthecompany’informationon floppy disk.
When you choose this option, Tally prompts you to select a company whose backup you wish
to take.
F4: Restore: Thisoptionallowsyoutoretrievetheinformationofcompanywhosebackuphad been
taken by you.



FII:Features:Thisenablesyoutogetthespecialfeatureslikeintegratingaccountsand inventory,
invoicing, cheque printing, etc.

LISTOFGROUPUNDERTALLY

ACCOUNT PAYABLE
SUNDRYCREDITORS&SUNDRYDEBITORS
SUSPENSE ACCOUNT
TEMPORARYACCOUNT
UNSECUREDLOANS&SECUREDLOANS
ACCOUNT RECIEVEABLE
ADMIN.EXPENSES
BANKACCOUNT&BANKOCCA/C
BRANCH/ DIVISIONS
CAPITAL ACCOUNT
CASH IN HANDCURRENT
ASSETS CURRENT
LIABILITIES DEPOSITS
(ASSETS) DUTIES AND
TAXES
EXPENDITUREACCOUNT
EXPENCE (DIRECT)
EXPENCE (INDIRECT)
FIXED ASSETS
IMMOVABLEPROPERTIES
INCOME (REVENUE)
INVESTMENT
LOAN&ADVANCES(ASSETS)
LOAN (LIABILITY)
MFG. / TRDG. (EXPENCE)
MISC.EXPENCES(ASSETS)
PROVISIONS
PURCHASE ACCOUNT
RESERVES&SURPLUS
RETAINED EARNINGS



REVENUEACCOUNTS
SALES ACCOUNTS
STOCK IN HAND
SUBSIDIARYFARMS&SUNDRY FARMS

Introduction
BANKING SYSTEM

The Banking Sector is the most dominant sector of the financial system in India, and

with good valuationsand increasingprofits,the sectorhasbeenamongthetop performers in

themarkets.Bankingdatesback to 1786, thefirst bankestablished in India,then the

nationalizationofbanksin1969.InIndiathebankingsectorisSeparateaspublicorprivate sector

banks, cooperative banks and regional rural banks. Foreign banks have been givena

different head followed by upcoming foreign banks in this section. Bunch of services are at

customers demand in today’s banking system. Different types of accounts and loans,

facilitating with plastic money and money transfer across the globe.

Banking IndustryinIndia

TheGeneralBankofIndiawassetupintheyear1786.NextcameBankof

Hindustan and Bengal Bank. The East India Company established Bank of Bengal (1809),

Bank of Bombay (1840) and Bank of Madras (1843) as independent units and called it

Presidency Banks. These three banks were combined in 1920 and Imperial Bank of India was

established which started as private shareholders banks, mostly Europeans shareholders.

In 1865 Allahabad Bank was established and first time exclusively by Indians, Punjab

National Bank Ltd. was set up in 1894 with headquarters at Lahore. Between 1906 and

1913, Bank of India, Central Bank of India, Bank of Baroda, Canara Bank, Indian Bank,

and Bank of My sore were set up. Reserve Bank of India came in 1935. During the

firstphasethegrowthwas veryslowandbanksalsoexperiencedperiodicfailures between 1913

and 1948. There were approximately 1100 banks, mostly small. To streamline the



functioningandactivitiesofcommercialbanks,theGovernmentofIndiacameupwithThe Banking

Companies Act, 1949 which was later changed to

Banking Regulation Act 1949 as per amending Act of 1965 (Act No. 23 of 1965). Reserve

Bank of India was vested with extensive powers for the supervision of banking in India as

the Central BankingAuthority. Duringthoseday’s public haslesserconfidencein thebanks. Side

by side of it the savings bank facility provided by the Postal department was comparatively

safer.

Government tookmajor steps inthis Indian BankingSector Reform after independence. In

1955, it nationalized Imperial Bank of India with extensive bankingfacilities on a large scale

especiallyin rural and semi-urban areas. It formed State Bank of India to act as the principal

agentofRBIandtohandlebankingtransactionsoftheUnionandStateGovernmentsallover the

country.

Seven banksformingsubsidiaryof StateBank of India was nationalized in 1960 on 19th

July1969,majorprocessof nationalizationwascarriedout.Itwastheeffortof thethen

PrimeMinisterofIndia,Mrs.IndiraGandhi.14majorcommercialbanksinthecountrywere

nationalized. Nationalization of Indian Banking Sector Reform was carried out in 1980 with

seven more banks. This step brought 80% of the banking segment in India under

Government ownership.

Afterthenationalizationofbanks,thebranchesofthepublicsectorbankIndiaraisedto

approximately800% indeposits andadvances tooka huge jumpby11,000%.Bankingin the

sunshine of Government ownership gave the public contained faith and huge confidence

about the ability of these institutions.

This phase has introduced many more products and facilities in the banking sector in its

reformsmeasure.In1991,underthechairmanshipofMNarasimham,acommitteewasset up by

his name, which worked for the liberalization of banking practices. The country is flooded

with foreign banks and their ATM stations. Efforts are beingput to give a satisfactoryservice

to customers. Phone banking and net banking is introduced.The entire system became

more convenient and fast. Time is given more importance than money.

ReserveBankofIndia(RBI): RBIisthecentralbankofthecountrysince1934.Itregulates, controls
credit, issue licenses and functions as banker of all banks and the government.



Various Banking Operation & Bank Deposited: Bankingisanimportantaidtobusiness.A
bank may be defined as an institution which deals in money. The bank pays a certain

amount of money as interest, on the money they have borrowed. Similarly they charge

interest on the money lent. Interest is always calculated at a certain rate presented per

annum. The rate of interest on loans advanced is always greater than that on deposits.

Thedifferencebetweenthetworatesisthebanksmarginofincome.

Looked at from a different point ofview, a bank may be said to be a dealerin the

moneymarket.Inthemoneyfinancemarket,moneyistheitemthatisboughtandsold.

Banks act as middleman between the savers and borrowers of money. The differencebetween

thebankssellingprice andpurchaseprice isthe banksincome.Thereare threemain types of

accounts which a person can open with a bank, namely fixed deposit, saving bank deposit and

current accounts.

Fixed Deposit Account: A customer can deposit hismoneywith a bankfor a fixed period.
Such an account is called ‘fixed deposit account’ usually varies from fifteen days to five

years.Theamountdepositedcannotbewithdrawnbeforetheexpiryofthefixedperiod.The

banknormallyallows a higher rate of interest on fixed deposits. The rate of interest increases

with the period of deposit. Bank offer veryhigh rates of interest on such deposits

becauseitisassuredoffundsfortheperiod.Ifthedepositorisinneedofmoneyinbetween

hemayborrowupto70%ofthedepositat2%abovetheinterestrateapplicabletothat particular

deposit.

Saving Bank Account: A saving bank account provides limited withdrawal facility and
carries a moderate rate of interest on deposits. Interest is allowed on the saving bank

account on the lowest credit balance kept in a particular month. Some restrictions are

placedonwithdrawals.Furtheraspecifiedminimumbalancemustalwaysbemaintainedin the

account.

Current Bank Account:A current account may be defined as a running account between
a banker and a customer. Customer can deposit money into or withdraw money from a

currentaccountwhenevertheylike.Therearenorestrictionstothenumberofwithdrawal,

subject,howevertotheminimumcreditbalancetobekeptaspertheruleofthebank.Asa rule no

interest is allowed on a currentaccount. An exception however is sometimesmade



ifthecreditbalanceinacurrentaccountisnotallowedtofallbelowaprescribedfigure.In other words

current account is simply a business account.

Bank Cheque: Achequeisanunconditionalorderonthebankmadebyaclientinstructing
thebanktopayondemandacertainsumofmoneytoortotheorderoraspecifiedperson or to a

bearer. In otherwords, when a traderwants to discharge hisdebtshe signs a written

orderonhis bank authorizingthe bank to paya certainsum of money-to his creditor. The

order is known as ‘cheque’.

Types of Cheques: BearerCheque: Abearerchequeismadepayabletothebeareri.e.it
ispayabletothepersonwhopresentsitto thebankforencashment.Thelanguageofsuch a

chequerunsthuspayto Xor bearer or self.It is payable toanybody who presents itat the

counter.

Crossed Cheque : Crossedchequearethosewhichcannotbeencashedatthecounterbut which
can be collected only by a bank from drawee bank. A cheque is crossed by drawing two

Cross lines across its face with or without Account Payee only words.

VATVALUE
ADDEDTAX Whatis VAT?
VAT or Value Added Tax is a consumption tax, which is charged at each stage of

production based on the value added to the productat that stage.ManyStates in India have
adopted VAT in place of sales tax. In the sales tax structure, there are problems of double
taxation of commodities and multiplicity of taxes, resulting in a cascading tax
burden.Forinstance,inthesalestaxstructure,beforeacommodityisproduced,inputsare
firsttaxed,andthenafterthecommodityisproducedwithinputtaxload,outputistaxed
again.Thiscausesanunfairdouble taxationwith cascadingeffects.In theVAT,a set-off is
givenforinputtaxaswellastaxpaidonpreviouspurchases.Inthesalestaxstructurethat existed in
India and still exists in some states, there was multiplicity of taxes such as turnover tax,
surcharge on sales tax, additional surcharge, etc.
WithintroductionofVAT,theseothertaxeshaveabolished.Inaddition,Centralsalestax is also

going to be phased out. As a result, overall tax burden will be rationalized, and prices in
general will also fall. Moreover, VAT will replace the existing system of inspection by a
system of built-in self-assessment by the dealers and auditing. The tax structure will
become simple and more transparent. That will improve tax compliance and also increase
revenue growth.



VAT is a modern and simplified system of taxation where the tax is levied and collected
at each stage onthe valueadditionswith a provision forsetoff against taxpaid atthe various
stages / tax paid on inputs. VAT is a system of indirect taxation, which has been
introduced inlieu of salestax. It isthetaxpaidbythe producers,manufacturers,retailers or
anyother dealer who add value to the goods and that isultimatelypassed on to the
consumer. VAT has been introduced in India to ensure a fair and uniform system of
taxation. It is an efficient, transparent, revenue-neutral, globallyacceptable and easyto
administertaxationsystem.Itbenefitsthecommonman(consumer),businessmanandthe
Government.
Further, VAT enhances competitiveness by removing the cascading effect of taxes on

goods and makes the levy of tax simple and self-regulatory, ensuring flexibility to generate
large revenues. The cascading effect is brought about by the existing structure of taxation
where inputsare taxedbefore a commodityis producedand the output is taxed after it is
produced. This causes an unfair double-taxation. However, in VAT, a set-off is given for
input tax (tax paid on purchases). This results in the overall tax burden being rationalized
andafallinpricesofgoods.Thisconceptisexplainedwithanexample,intheComputation of VAT
section.

VATworksintwodifferentways:
IfVAT-registeredbusinessesreceivemoreoutputtaxthanthetaxespaidasinput,theywill need to

pay the difference to the Commissioner of Taxes (State).
If the input tax paid is more than the output tax collected, you can carry forward the Input

credit and adjust itagainst the output taxin the subsequentmonths.
YoucanhavetheInputCreditrefundedtoyouattheendofthecurrentorfollowingyear,by the

Government.
YoucanreceiverefundsforInputCreditonexportswithinaperiodofthreemonths.

Term Description
Input tax Thisisataxpaidonpurchases
Output tax This is a tax charged on sales
Input Credit The amount of Input tax that is

permittedtobesetoffagainstOutputtax.
VATRates
According to the White Paper, there are 550 categories of goods under the VAT
system.Theyareclassifiedintothefollowingfourgroups,dependingontheVATrate:

VAT@4% :The largest number of goods (270) comprising of basic necessity items such as
drugsandmedicines, agriculturaland industrialinputs,capitalgoodsanddeclared goods are
under 4% VAT rate.

VAT@1%:Thisisforaspecificcategoryofgoodslikegold,silver,etc.

VAT@12.5%:TheremainingcommoditiesareunderthegeneralVATrateof12.5%. Exempted

from VAT



Thereareabout46commoditiesundertheexemptedcategory.Thisincludesamaximumof
10commoditiesthateachstatewouldbeallowedtoselect,fromabroaderapprovedlistfor VAT
exemption. The exempted commodities include natural and unprocessed products in
unorganized sector as well as items, which are legally barred from taxation.

Note: ThefewgoodsthatareoutsideVATasamatterofpolicywouldincludeliquor,lottery tickets,
petroleum products, asthe pricesof these itemsare not fullymarketdetermined.
Theseitemswillcontinuetobetaxedunderthesalestaxactoftherespectivestates.

Registration Proves
For ExistingDealers

1) Allthe registered dealersunderthe PGSTact 1948 shallapplyin VAT-I form with in 30 days of
the appointed day.

2) Oldregistrationcertificatestobeattachedinoriginal.
3) Noapplication fee.
4) Anelevendigit(TIN)Taxpayeridentificationnumberhasbeengeneratedandisavailableon the
official website i.e. www.chandigarh.nic.in, Excise andTaxationDepartment Chandigarh and
shall be communicated by post.

ForFresh/ Newdealers.
1) ApplicationforregistrationunderVATacttobesubmittedintheformVAT-I,alongwith application
fee of Rs. 500/-
2) Theapplicationhastobesubmittedwithin30daysofapersonbecomingLiabletopayTax.

SERVICE TAX

Service tax is tax of 21st Century. Service Tax is a form of indirect tax imposed on
specified services called “taxable services”. Service tax cannot be charged on any service
which is not included in the list of taxable services. Over the past few years, service tax
been expanded to cover new services. The intention of the government is to gradually
increase the listof taxable services untilmostservices fallwithin thescopeof service tax.
Highlights of the service tax are as follows:
1.ServicetaxisimposedunderFinanceAct,1994asamendedfromtimeto time. 2.

Service tax is payable @ 12% plus education cess of 2%, plus SAH education cess of 1%
(total12.36%)we’ve.11thMay2007[Section66].(TheexemptionlimitwasRsfourlakhsup to 31-3-
2007).
3. Servicetaxispayableontaxableservicesasdefinedinvariousclausesofsection65(105) of
Finance Act, 1994. Presently, about 99 services are taxable.
4. Servicetaxispayableongrossamountchargedfortaxableserviceprovidedortobe provided
[Section 67].

http://www.chandigarh.nic.in/


5.Presently Service tax is payable @ 10% plus education cess of 2%, plus SAH education
cess of 1% (total 10.36%) & Small units whose turnover less than Rs. Ten lakhs per annum
are exempt from service tax.
6. Every provider of taxable service should apply for registration in form ST-1 within 30 days
from date of charge (in case of new services) and date of commencement of business of
providing taxable services.

7. Assessee providing service from various premises can have centralized registration [Rule
4(2)]

8. Ifpaymentoftaxisdelayed,interestispayable@13%[Section75]
Invoice byservice provider
Assesses should prepare invoice in respect of his services. Details required to be shown

in invoice/bill/Chillan - As per rule 4A (1), the invoice/Chillan/Bill should be signed by
authorized person of provider of input services, should be serially numbered and should
contain following details -
1. Name,addressandregistration
number of person providing
taxable service 2.
Description, classification and
value of taxable service provided
or to be provided and Education
Cess and SAH Education Cess
(Sec & Higher Edu. Cess) to be
shown separately - Education
Cess and SAH Education Cess to
be shown separately in the
InvoiceforcomplyingwithrequirementsofCentralCreditRulestofacilitateaailmentofCentral credit by
recipient – para 5.1 CBE&C Circular No. 97/8/2007-ST dated 23-8-2007.
ProceduresofServicetax
Administration of servicetaxisunderCentralExcisedepartment.Themainproceduresto be
followed are -1.Registration
2. Maintenanceofrecords3.
Paymentof servicetaxand
4.Halfyearlyreturn.
There are no prescribed forms of records. The records maintained by assesses including
computerized data maintained by assesses in accordance with various other laws are
acceptable [rule 5(1)].
RegistrationunderServiceTax:A‘personliableforpayingservicetax’hastoregisterwith
Superintendent of Central Excise under whose jurisdiction your premises fall. He should
register within 30 days from date of commencement of the business of providing taxable
service. The person will have to apply for registration in form ST-1.If a person is providing
morethanonetaxableservice;hemaymakeasingleapplication.Heshouldmentioninthe
application all the taxable services provided by him. [Rule 4(4)]. Applicant should submit
followingatthetimeoffilingapplicationforregistration:
1. CopyofPAN
2. Proof of Residence and 3.Constitution
of applicant.



Theregistrationcertificatewillbe grantedbySuperintendentofCentralExciseinseven days in form
ST-2.
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